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YOU CANT PLEASE ALL OF THE PEOPLE ALL OF THE TIME 

W
hen I started my company 

in 1992, I had a lot of plans. 

I began slowly, part-time, on 

the side, out of my apartment in Chicago. 

In 1994, I started working full-time for 

myself. A couple of years later, we had 

office space, audio production, and video 

support. My plans were now bigger. This 
summer, I celebrated 10 years in business, 

with some good days, some bad, and 

I wouldn 't have changed a thing. Well, 

maybe a few things! But through all of it, 

one thing I have learned is that you can 't 

please all the people, all of the time. And 

even though I have tried, many times at 

my own expense, some people just have 

their minds made up. 

Recently, I heard from a good friend 
about another "colleague" who was 

badmouthing my books in his own 

seminars. This isn't the first time I've 

heard about this happening either. I'm 
not sure why, and I probably never will 

be. But I rest easy in the fact that you just 

can't please all the people all of the time. 

Our first issue of HDRI 3D Magazine hit 

the streets in November 2004. I've heard 

from so many readers and they are not 

only happy with the first issue, they are 

quite surprised. I'm not sure what they 
thought the magazine would be, but 

perhaps they underestimated the team at 

DMG Publishing. Others, however, couldn't 

say enough bad things about it. The name 

was bad, the layout, the content, and so 

on. But I remember, you can't please all the 

people all of the time. 

As we head on into issue #2, I'd like 

to extend a warm welcome to Dariush 

Derakhshani and Raffael Dlckreuter to 

the editorial team for our upcoming third 

issue. They will bring their expertise and 

skills to the publication, adding to our 

ever growing content. Their talent might 

help us please more people. I'd also like 

to thank all of the hard working people 

that make this magazine possible every 

issue, especially Amber Goddard, Brad 

Carvey, and David Wilkinson. Add to that, 

our readers. Thank you for your feedback, 

ideas, and comments on HDRI 3D issue 
# I. We'll continue to expand our coverage 

of software and extend our features with 

every issue. Keep on reading, and we'll 

keep trying to please. 

~~ 
EDITOR-IN-CHIEF 
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BY BRAD CARVEY 

LW ESSENTIALS---------

30 1EX1 

© 
reating cool looking 3D text is fun and easy with LightWave. 

There are lots of interesting effects possible with the tools in 

LightWave. LightWave [8] has some new tools that make the 

task even easier. In this article, we w ill use LightWave Text, Bevel, and 

Extrude tools to create 3D text with extruded edges. 

ADDING A FONf TO MODELER 

I) Open the ''Edit Font List"window [Modeler / Options/ EditFontList](for 

LW 7.5) or the "Manage Font" window (FlO) (for LW 8.0). See 

Figure I. 

2) Select "Add True-Type." 

3) Select a font. (In this tutorial, "Aria! Black" was used.) 

4) Click "OK." 

CREATE TEXT 

5) Activate the 'Text" tool (Create/Text. or press Shift + w ). 

6) Open the Numeric window (n). 

7) Type the desired text in the 'Text" field. See Fligure 2. 

8) Close the Numeric w indow. 

9) Commit the text by deactivating (clicking) on the 'Text" tool 

button . 

BEVEL AND EXTRUDE TEXT 

10) Select Multiply/ Extrude, or press Shift + e). 

II) Open the Numeric window (n). Enter a value in the Z "Extent" 

field. See Figure 3. Close the Numeric window. 

12) Commit the Extrude by deactivating the "Extrude" tool (click on 

the "Extrude" button). 

13) Select the polygons on the front of the text. 

14) Activate the "Bevel" tool (b). Open the Numeric window (n). 

15) Set the "Inset" value to 30 mm. Select the "New Surface" check 

box. Enter a name for the new surface (TextEdge). Close the 

Numeric window. 

16) Deactivate the "Bevel" tool (b) and then deselect the polygons. 

17) Open the "Polygon Statistics" w indow (w). 

18) Select the 'TextEdge" surface and click on the "+" to select the 

polygons with the TextEdge surface. See Figure 4. 

19) Close the "Polygon Selection" window. 

20) Activate the "Extrude" tool (E). 

2 1) Open the Numeric window (n), and enter a value 30 mm in the "X 

Extent" field. 

22) Commit the Extrude by clicking on the "Extrude" button. 
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FIGURE 5 
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23) The extruded polygons wi ll be inside/ out. To ftx them, first open 

the "Polygon Statistics" window (w). Select the polygons with the 

'TextEdge" surface. Then, Flip the polygons (f). 

ASSIGN SURFACE COLORS 

24) Select the polygons that make up the SIDES of the text (NOT 

'TextEdge," the front, or the back). 

25) Open the "Change Surface" window (q). Type in the desired name 

(TextSides). Click on "Smoothing ," then "OK." Deselect polygons. 

26) Open the "Polygon Statistics" window (W ), Select 'TextEdges," 

and 'TextSides" polygons. 

27) Select inverted polygons (click "Display/ Sellnvert" or(")). 

28) Open the "Change Surface" w indow (q ). Type in the desired name 

(Textface), then "OK". Deselect polygons. 

29) Open the Surface Editor (Ctrl + F3). 

30) Select the 'TextSides" Surface. 

3 1) Under the "Basic" tab, locate "Smooth Threshold," and change the 

value to about 50°. This will smooth the rounded edges. but keep 

the flat surfaces flat. 

32) Select the 'TextEdge" Surface, and change the "Smoothing 

Threshold" value to about 50°, as well. 

33) Adjust all the surfaces as desired. 

To create the fi nal image, I used the radiosity dome discussed 

in a previous Lig htWave Essentials ar ticle and added one area 

light. I also adjusted the surface attr ibutes for red and yellow 

areas . See Figure 5 . • 
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BRAD CARVEY 
HAS BEEN DOING 
CO M PUTER 
ANIMATIONS FOR 
A LONG TIME. IN 
1969, BRAD USED 
AN ANALOG 
COMPUTER , 

WHICH WAS THE SIZE OF A CAR, TO PRODUCE 
HIS FIRST COMPUTER ANIMATION. BRAD IS AN 
ELECTRICAL ENGINEER AND AN EMMY AWARD­
WINNING MEMBER OF THE VIDEO TOASTER 
DEVELOPMENT TEAM. HE PREFERS TO DO 
FEATURE FILM WORK. HIS CREDITS INCLUDE 
FILMS LIKE MEN IN BLACK, STUART LITTLE, 
BLACK HAWK DOWN, KATE & LEOPOLD AND 
MASTER OF DISGUISE . 

.JANUARY I FEBRUARY 200 5 



CREATING THE ARTWORK ON THE COVER OF THIS ISSUE 

U 
he artwork I create presents an 

arrangement of elements that 

express emotions and feelings. 

The elements are vaguely representa­

tional symbols from that place between 

the dream state and psychosis. By scan­

ning natural media and integrating the 

scans with dig ital painting, drawing and 

3D, I work with heart and mind devoted 

to the f inal image. 

This piece, called "Fedoras 'n ' Argyle" 

(Cover art), relied on Carrara 3, Adobe 

PhotoShop 7, Illustrator 10, a bit of 

photography, a scanned watercolor 

and Painter 8 . There are some elements 

that combine a texture map and vectors 

that Carrara was able to bring to life. 

Carrara's spli ne m odeling room gave me 

the f lexibility to experiment with radical 

shapes and the precision to model spe­

cific forms. 

In this piece I did just that; I used 

Carrara's modeling capabilities to build 

fantastically wild shapes using utterly 

hairball sweep paths to convolute what 

was basically a warped hot dog spline 

object (Figure A &. lA). just a bit later in the 

process, I was able to use the same m od­

eling room to build handsomely blocked 

fedoras and a beautifully rendered glass 

oil lamp (Figures B &. C). 

I wanted the shapes to have a "bad 

plaid " texture (Figure D). The kind of 

plaid worn by those o ld farts you see at 

the mall - you know the ones, wearing 

white shoes and belt, black knee-high 

socks, three d ifferent plaids- one for the 

baggy shorts, one fo r a too tight shi rt , 

and of course another for a dashing 

fedora. (Hey good lookin'!) 

I used Carrara 's texture room to map 

the same texture onto a variety of shapes 

w ith the same tile-able "bad plaid" )PEG. 

I made my own plaid ti le in PhotoShop 

7. It is a file with 23 layers, with most 

layers set to Hard Light mode, som e 

set to M ultiply, others set to different 

opacities. Each layer was nothing more 

than a few rectangles f i lled with different 

earth tones. By changing layer settings 

and stacking order, I was astonished at 

the mu ltitude of variations I was able 

to come up w ith. (I could have made a 

new plaid for every Scottish clan on the 

moor.) For the final touch, in PhotoShop 

I chose a texture (Filter > Texture > Tex­

turizer > Canvas) for the cloth plaid map 

that gave the final rendered forms that 

look of an exquisitely cheesy trailer-trash 

couch - ahh, per fection ! 

By mapping the sam e JPEG onto the 

different elements in the piece, I was able 

to establish repetition . The repeti tion of 

the p laid texture was counterbalanced by 

the free flowing watercolor background. 

The background colors were echoed in 

the repeati ng argyles. I used Il lustrator 

to generate the small fedora repeat back­

ground using the Shape Blend tool. My 

u ltimate goal was an effect of a jumbled 

and frantic array. The complexity of like 

patterns would challenge the viewer 's 

natural tendency to t ry to piece together 

a cohesive image. Of course, the viewer 

never would, but wou ld be subject to 

eye flow and the less obvious in terplay 

of recognizable objects. 

One of the design principles I like to 

work with is establishi ng symmetry and 

"breaking" symm etry. With Carrara's 

Metaball modeler, I built organic shapes 

and combi ned them w ith simple primi­

tive spheres (Figure £). These elements 

I arranged in PhotoShop to create the 

q uasi-asymmetr ical foundation (Figure F) 

for the fedoras and argyle shapes to be 

hidden and discovered. 

FIGURE A 

FIGURE 1A 

FIGURE B 

FIGURE C 

I 
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Orchestrating all of the various 3D 

shapes, vector shapes, textures, and 

watercolor in Photoshop is w here I 

enjoy overlapping, interweaving, hiding 

I revealing the elements to make the 

composition. As you might guess, I like 

a kind of "chutes &. ladders" eye flow in 

my work- my intention is for the v iewer 

to have fun zipping up, down , around, 

and through my art, stopping to snack 

on visual munchies along the way. If 

afterwards their senses are reeling from 

an aftertaste combining three-month 

o ld butterscotch candy (that was stuck 

between the cheesy couch cushions) 

and nicotine-stained polyester, I have 

succeeded. -

FIGURE E 

FIGURE F 

PHILIP TIMPER BEGAN 
TO OIL PAINT AND STUDY 
COLOR THEORY WITH JUNE 
KELLY IN 1963 AT THE AGE 
OF NINE, AND CONTINUED 
TO WORK UNDER JUNE 
KELLY UNTIL 1971. HE 
PRACTICALLY LIVED IN THE 
ART DEPARTMENT DUR­

ING HIGH SCHOOL. SOMEHOW, HE GRADUATED 
AND STUDIED FINE ART AT SOUTHERN ILLINOIS 
UNIVERSITY AT EDWARDSVILLE AND RECEIVED 
A BACHELOR'S DEGREE IN FINE ART IN 1980. 
TIMPER DREW CARICATURES AND DID NEWS­
PAPER ILLUSTRATION AND PAINTED MURALS AS 
PART TIME WORK DURING THOSE YEARS. lATER, 
HE FOUND HIMSELF IN THE COMMERCIAL ART 
WORLD AND BECAME THE "GO-TO GUY" FOR 
CREATIVE SOLUTIONS FOR PRODUCT DEVELOP­
MENT AND PROMOTIONS AT VARIOUS COMPA­
NIES. TODAY HE AND HIS WIFE RUN THEIR OWN 
SUCCESSFUL DESIGN BUSINESS IN SOUTHERN 
CALIFORNIA (WWW.TIMPERARTS.COM). 
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t's a bit of cliche for special effects 

artists to say how influential the movie 

Star Wars has been on their life and 

work. But far be it for me to let a good cli­

che die! Therefore, I must say, Star Wars has 

been a huge influence on my life and work. 

Growing up in Montreal, my brothers and 

I would take the bus into town from Nun's 

Island, use our paper route money to get in 

to a matinee, and then hide under the seats 

between showings so that we could watch 

the movie over and over again. 

So it happens that Star Wars (AKA Episode 

IV: A New Hope for the nerds out there) is 

the inspiration for this tutorial. I've always 

loved the style of the computer interfaces 

in the series and it occurred to me that it 

wouldn't be too difficult to create something 

similar using Maya's Paint Effects module. 

Specifically, I thought of the briefing scene 

before the rebel pilots' attack on the first 

Death Star. That scene includes an animation 

on a computer screen showing the rebel 

pilots the path they'll have to take down the 

infamous trench towards the exhaust port. 

This tutorial will show you how to create 

something similar, which you can then use 

for computer displays in the scenes you 

create. 

The primary tools I used are NURBS 

curves, simple polygon geometry, and the 

neon brushes found in the glows folder 

in Maya's Paint Effects module. If you 've 

never used Paint Effects before, this tutorial 

will give you some ideas on applications 

that go beyond just painting grass, trees, 

and hair into a scene. The neon brushes in 

Mtfi(a 3D 1ssuE 2 
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FIGURE 1A SHOWS THE THREE PROFILES THAT WILL BE USED TO EXTRUDE THE TRENCH GEOMETRY. 
FIGURE 1 B SHOWS THE EXTRUDED TRENCH AND SETIINGS 

the Paint Effects module have become an 

addiction of mine. They are very simple, 

easy to use, and versatile for creating these 

types of futuristic computer screen effects. 

Here's how I created my homage to the 

Star Wars computer display. 

PART 1- CREATING THE TRENCH 

11 created three profile curves using 

the 0/ Curve Tool. In the 0/ Curve 

Tool option box, I set the curves to Linear 

rather than Cubic so they would have nice 

sharp angles. It's easiest to do this in an 

orthographic view with Grid Snapping 

engaged. I made sure the curves were the 

same height and about the same width. 

Once they looked pretty good, I turned off 

Grid Snapping and moved the 0/s around 

a little more. See figure Ia. 

21 spaced these profiles evenly and then 

extruded them. In the options for Extrude, 

I chose Distance and extruded each of them 

about 12 units in Z. See figure lb. 

31 deleted history on these NURBS 

surfaces and then tightened their 

spacing a little. It doesn't need to be 

terribly precise. 

4To create the detail that will actually 

define the trench on the computer dis­

play, I created a number of simple shapes 

and circles using more linear 0/ curves. 

I drew these in the top view camera and 

• 
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FIGURE 2-A PATIERN OF SIMPLE SHAPES MADE FROM NURBS CURVES ARE PLACED ABOVE THE 

TRENCH GEOMETRY IN PREPARATION FOR CURVE PROJECTION 

FIGURE 3- THE RESULT OF PROJECTING THE CURVES ONTO THE GEOMETRY. THE CURVES ON SURFACE 

HAVE BEEN DUPLICATED AND THE TRENCH GEOMETRY HAS NEEN HIDDEN 

MAYA TUTORIAL 

translated them in Y so that they were 

above the trench. In many cases, I just 

duplicated a shape several times and then 

translated, rotated, and scaled it to fill out 

the pattern of shapes quickly. Generally, I 

try and keep the shapes simple so that the 

final detail doesn't become overwhelming. 

See figure 2. 

51 selected the curves and the NURBS 

trench geometry and projected the 

curves onto the geometry from above. 

The quickest way to do this is to g roup 

all of the curves, move them above the 

NURBS trench, select the g rouped curves 

and then all three NURBS trench surfaces, 

and choose Edit NURBS>Project Curve on 

Surface. I find that the default settings 

work well enough. In this case, I wanted 

to project down onto the trench geometry, 

so I switched to the top view and selected 

"Project along Active View" in the option 

box for "Project Curve on Surface." 

61t takes a few seconds, but the curves 

on surface w ill appear projected on the 

geometry. I wanted to duplicate these new 

projected curves so that I could hide the 

geometry and then apply my Paint Effects 

brush to the curves. To do this, I turned 

geometry off in the Selection Mask menu, 

made sure the Curve Selection mask was 

on, and then marquee selected around all 

the geometry, which then selects just the 

curves on surface. 

71 duplicated these curves using Edit 

Curves>Dupllcate Surface Curves. With 

these curves selected, I deleted their history 

to make the scene a little speedier. This 

is not an absolutely necessary step, and 

sometimes I leave history on if I decide I 

want to animate these curves by deforming 

or animating the original NURBS geometry. 

8To neaten things up a bit, I put the 

original NURBS geometry on its own 

display layer and then grouped the new 

curves and put them on thei r own display 

layer. Turning the NURBS geometry layer 

off will show how the w ireframe trench w ill 

look. See figure 3. I also deleted the o riginal 

detail curves I used for the projection 

above the trench . 
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9 At this point, the trench looks pretty cool, 

but it could use a few improvements 

before attaching the Paint Effects strokes. I 

used the E.P curve to close up some of the 

gaps in the projected wireframe and Curve 

Snapping to help place the ends of the E.P 

curves on the curves of the w ireframe trench. 

I also added some detail by pladng a few 

NURBS circles on the walls of the trench. 

1 OThe next step is to apply a Paint Ef. 

fects stroke to these curves. I do this 

by opening up the visor to the Paint Effects 

brushes folder, selecting the blue neon 

brush from the glows subfolder, and tern­

plating its settings. In the Rendering menu 

set, there is a menu for Paint Effects. I select 

the command 'Template Brush Settings." 

11 1 selected all the curves that made up 

my wireframe trench in the outliner 

and chose (under the Rendering menu set) 

Paint Effects>Curve Utilities>Attach Brush to 

Curves. You may notice, at this point, that 

I have not switched from the perspective 

window into the Paint Effects panel. I rarely 

do when I'm creating this kind of effect. It 

slows things down and it's not really neces­

sary; I do pretty much everything in the 

perspective and orthographic displays. 

12 Once the strokes are created, I select 

them in the outliner and choose 

Paint Effects>Share One Brush. This way I 

can make adjustments to one stroke and the 

rest w ill update accordingly. I usually hide 

the strokes in my modeling view to keep 

things working quickly (in the Panel View 

options, unchecl< Strokes from the Show 

menu). They will sti ll render even though 

they are not being d isplay ed. 

13 Before I began adjusting the brush 

settings, I created a camera that 

would g ive me an idea of what the final 

render would look like. I put this camera at 

one end of the trench and create some key­

frames so that it w ill move to the other end 

of the trench over the course of 300 frames 

or so. To increase the d ramatic effect of the 

animation, I decreased the focal length of the 

camera to about 10. Take a look at figure 4 

to see how the rendered Paint Effects trench 

looks at this point. I'm rendering with Maya's 

~~~~ 3~ ISSUE 2 

FIGURE 5- THREE EXAMPLES OF THE TRENCH RENDERED WITH DIFFERENT SETTINGS APPLIED 
TO THE BLUE NEON GLOW BRUSH ATTRIBUTES 

software rendering engine, not mental ray. 

Mental ray requires a plug in to render Paint 

Effects strokes (you can find one by doing a 

search on the Internet). 

1 A I select one of the strokes in the out­

Afrliner and open up its Attribute Editor 

so I can start playing with the brush settings. 

These settings are found under the tab labeled 

··neonBiueXXX," where XXX is the number of 

the stroke. If Brush Sharing is on, this number 

will be the same for all the strokes that make 

up the trench. Brush Sharing is very handy 

when you have several hundred strokes in 

a scene that all share the same settings. The 

Global Scale of the brush is usually the first 

thing I play with. In this case, it was already 

close to what I wanted. Some additional 
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FIGURE 6- SIMPLE POLYGON SHAPES HAVE BEEN ADDED AND RENDERED WITH ALIGHT BLUE SURFACE SHADER. A 
BIG BLACK CUBE HAS BEEN ADDED TO SHORTEN THE LENGTH OF THE TRENCH. IT HAS BEEN POINT .CONSTRAINED 
IN Z TO THE CAMERA SO THAT THE TRENCH WILL APPEAR TO BUILD ITSELF AS THE CAMERA MOVES ALONG 

parameters I play with are the Brush Width, 

Color, Incandescence Color, Transparency, 

Brush Density, Gap Spacing and Gap Ran­

dom. There is no reason why you couldn't 

play with all the other setting s as well, but for 

the look I'm going for, these seem to work the 

best. Learning what a brush can do in Paint 

Effects involves playing with its settings to see 

what happens. It's easier to demonstrate than 

to describe, so look at figure 5 to see various 

renders and their settings: 

EXAMPLE 1 -

Brush type = Paint 
Global Scale = 2.224 
Brush Width = .025 
Stamp Density = 20 
Shading Color1 is a dark blue 
lncandescence1 is navy blue 
Glow = .174 
Glow Color is a light blue 
Glow Spread = 2 
Shader Glow = .05 

EXAMPLE 2 -

Brush type = Thinline 
Global Scale = 2 
Brush Width = .015 
Mu lti Streaks = 12 
Mu lti Streak Spread1 = .18 
Color1 is a dark blue 
Incandescence is a navy blue 
Glow=.132 
Glow Color is a light blue 
Glow Spread = .05 
Shader Glow = .05 

EXAMPLE 3-

Brush Type = Paint 
Global Scale = 2 
Brush Width = .045 
Stamp Density = 20 
Shad ing Color1 is a dark blue 
lncandescence1 is a navy blue 
Glow= .132 
Glow Color is a light blue 
Glow Spread = .05 
Shader Glow = .025 
Gap Size = .934 
Gap Spacing = .5 
Gap Rand = 1 

15The basic trench at this point is 

almost there, but after checking 

it out a few times from the animated 

camera view, I decided it could use 

some more detail and a little more ex­

citement. I wanted to have the fictional 

computer display animation build the 

trench as the camera flies through. To 

accomplish this effect, I made a large 

polygon cube, attached a black surface 

shader to it, and then set the shader's 

Matte Opacity to zero. The Matte Opacity 

at zero (or black) ensures that the cube will 

not show up in the alpha channel of the 

rendered images if I decide to composite 

the animation. 

161 animated the cube moving along 

the trench at the same rate as the 

camera by point-constraining the cube to 

the camera on the Z-axis only and then 

setting a Z offset of -20. I could have 

parented the cube to the camera and then 

just moved it back in Z, but I may want to 

add additional X and Y translations to the 

camera further on down the road and I 

don't want the cube moving up and down, 

or side to side. 

17Next, I added some simple polygon 

shapes and placed them along the 

trench. I assigned a surface shader to all of 

these objects and gave the shader a light 

blue color, a slight blue g low, and a little 

transparency. See fig ure 6. 

Now this trench looks a bit more 

respectable. In a still frame it just looks 

shorter, but when it's animated, the trench 

appears to be constructed as the camera 

moves down it. 

PART 2 - ADDING A N ENEMY SPACE­
SHIP AND TARGETING l f\ITERFACE 

For the next part of this tutorial, I decided 

to take this beyond the original concept of 

a simple fly -through animation and make 

it more suitable for a computer-targeting 

interface. To do this, I added an enemy 

spaceship for targeting and the interface 

elements. The next section will show how 

I made the computer display version of the 

enemy ship . 
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11 created the spaceship using tech­

niques similar to the ones I used for 

the trench . First I modeled a very simple 

NURBS ship. I created a profile curve and 

then did a Revolve and sculpted from 

there. It doesn't have to be very detailed, 

just somewhat spaceship-like. 

21 created som e NURBS circles and 

p rojected them onto the surface (like 

I did with the trench). Unli ke the trench, 

I projected from the side instead of the 

top. See fig ure 7. 

30nce I duplicated the sur face curves, 

I deleted the history on them, 

g rouped them, and centered the pivot 

point of the group. 

40nce again I opened the visor. This 

time, I chose the orange neon g low 

brush and templated its brush settings. 

51 selected all the curves that make 

up t he spaceship and attached the 

brush to them (Paint Effects>Curve 

Utilities>Attach Brush to Curves). 

61 selected all these new strokes and 

chose Paint Effects>Share Brush. Then 

I g rouped them. 

7The next step is to animate the 

spaceship. Animating the g roup of 

spaceship curves will work just fine, as 

these spaceship strokes will follow to 

their curves. 

8Then I created a path for the ship to 

follow. I drew a curve in the side view, 

moved the 0/s around, and attached the 

spaceship curves to the path curve using 

Animate>MotionPaths>Attach to Motion 

Path. I made the ship follow the curve, gave 

it some banking, and adjusted the time 

frame for the path so that it is just ahead of 

the camera. 

gNext, I deleted the keys on the camera, 

duplicated the curve the spaceship is 

attached to, moved its 0/s around a little to 

make it slightly different from the spaceship 

curve, and attached the camera to this new 

curve so that the camera is just behind the 

~rJ~a ~D ISSUE 2 

FIGURE 7-A SIMPLE NURBS SPACESHIP WITH CURVES PROJECTED ON FROM THE SIDE 

ship. Looking through the camera now as it 

Ries down the trench with its banking and 

sm all focal length should make you a little 

seasick. That's cool. The giant black cube I 

made still follows the camera, but only its Z 

translation because of the way I set up the 

point constraint. The cube doesn 't go up or 

down or side to side as the camera m oves 

along the curve. 

The last details I added to the scene are 

some targeting computer interface elements. 

1 OThe image is in danger of getting too 

busy, so I decided to keep the inter­

face e.lements simple. I created a triangular 

polygon object from a simple polygon plane, 

duplicated it three times, and arranged the 

results to look like a targeting reticle. 
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THESE MORE ABSTRACT PIECES OF SCI-FI IMAG­

ERY. THE PROFILE CURVES WERE CREATED IN 

ILLUSTRATOR AND IMPORTED INTO MAYA 

11 1 g rouped these polygons together 

and then centered the group's 

pivot point. 

12Again I point constrained the reticle 

g roup, but only in Z. I gave the 

3D MAP DISPLAYS AS WELL 

constraint node an o ffset of -2.5. 

131 also placed an orient constraint 

on the reticle g roup to the camera 

so that i t would constant ly face the 

camera lens. 

141 added some keyframes on the 

reticle in X and Y to make it look 

as if the pilot/target ing computer is try­

ing to hi t the spaceship . 

15The final scene is shown in figure 

8. More detai ls can be added 

using similar techniques, of course, but 

you have to be careful not to clut ter it 

up too much. The scene can be rendered 

out as a fi le seq uence, w hich can t hen 

be mapped to the incandescence of a 

shader applied to a computer screen or 

even a heads-up d isplay on the visor of a 

pilot's helmet. 

So there you have i t , a simple retro­

futuristic targeting computer. These 

techniques can easily be applied to a 

wide range of computer screen effects. 

I've included some examples of images 

to demonstrate some other ways I've 

used these techniques. * 

MAYA TUTORIAL 
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W hile working in production 

on projects, as well as lurking 

in various XSI user forums, 

one gripe continually come in contact 

with is the problems and limitations of 

shape animation workflow for creating 

deformations for use in lip sync, cartoon 

animation , and anything requiring an 

organic look. However, despite the prob­

lems, many users insist on continuing the 

use of shape animation, believing it's the 

only real option. Personally, I've never 

liked shape or cluster animation workflow 

due to its closed and laborious nature, so 

today I'd like to offer an alternative for 

those who are also tired of using shape 

animation. 

Shape animation, in XSI, is a method 

of animating a surface's shape directly by 

manipulating its points, then saving a 

snapshot of the surface as a shape key. 

The shape key is then blended w ith other 

shape keys of the same surface at different 

moments in time to provide the illusion of 

a deforming surface. Generally speaking, 

the in-betweening process works by inter­

polating the positions of all the points of the 

surface from one shape key to the next in 

linear fashion. That is, pick a point on the 

surface, and then draw a line connecting its 

current position to its position on the next 

shape key. The point will be moved along 

that imaginary line from the first shape key 

en route to the second shape key over the 

specified number of frames. The stored 

positions of the points in the shape key are 

relative to the object's center. 

Shapes are often used when an organic 

feel is needed, such as animating faces for 

lip sync, creating muscle bulges on charac­

ter limbs, or mocking up quick simulations 

of liquids that don't need to be particularly 

accurate. Many tools and 3rd party plugins 

utilize shape animation as the preferred 
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workflow to handle deformations such as 

the cloth simulations and some file import/ 

export tools. The shape workflow is often 

the first choice for its simplicity of setup 

and use. There is also a plethora of mixing 

and blending options for shapes that allow 

additional new shapes to be generated from 

existing shape keys, w hich can help to add 

exaggerations when needed. 

While the shape animation workflow is 

fairly simple and straightforward to use, 

i t comes w ith a number of limitations 

that may frustrate the animator seeking 

precise control, along w ith providing a 

few surprises: 

1 Most shapes are in-betweened in a 

linear fashion. That is, points move 

from their positions on the first shape 

key in a straight line to their positions in 

the next shape key, w hich makes it quite 

difficult to create motion where portions 

of the surface need to rotate or move in 

an arc-like fashion (think of a long ribbon 

flowing through air or water). Some of 

the available shape blending modes 

can alleviate this to a degree, but not 

completely. The workaround is to create 

extra shape keys as in-betweens to fill 

in the gaps - which brings us to issue 

number two ... 

2 Shape animation can be a very labori­

ous process. In many cases, almost 

every point on the surface needs to move 

by some degree in every shape key for 

proper in-betweening to take place. 

This can be problematic w hen motion 

is very subtle, as there are no guides to 

judge exactly how much to move a point 

- or which point to move - in order to 

get the desired look. The end result is 

often a surface that appears to creep or 

crawl. The new secondary shape anima­

tion mode in the operator stack helps, 

but can be a pain, as you are limited to 

visual inspection without any methods to 

numerically compare shape keys to see if 

the current shape is correct or properly 

biased towards the previous/ next shape 

key. That is, you must be able to put 

points exactly where they need to go 

with the mouse, as you cannot type in nu­

merical values to place a point precisely 

relative to a shape key. 

3 There is no access to the recorded 

values of the shape keys other than 

blend weight. When storing shape keys, 

pose clips are created for use in the anima­

tion mixer, but there is no information to 

preview a shape key or indicate how one 

pose differs from another, which points 

within the shape key have been altered, or 

by how much. Some form of scrubbing the 

timeline around clips inserted on dummy 

tracks in the animation mixer is usually 

involved. This is cumbersome to say the 

least. Sometimes it's helpful to know the 

position coordinates of points in the shape 

to determine how much it needs to be 

moved for the nex t key. 

4 Shape animation Umits options. Shape 

animation is based on changes in topol­

ogy of the affected object, whereas many 

other tools operate on the transformations of 

the kinematics property (such as constraints), 

which makes it difficult to blend the two 

workflows together or use the output of one 

to drive the other. If geometry is modified, 

the IDs of the points can become relabeled/ 

reordered, causing existing animation to be 

mangled or lost, as shape keys use IDs of the 

points to identify which ones are deforming 

on the surface. If a client asks for radical 

changes, you may have to scrap all your 

work and start again from scratch. There is 

nothing more deflating than losing valuable 

time and energy on a project which should 

be near completion. 
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XSI TUTORIAL 

ABOVE LEFT: SQUEAK RENDERED IN FULL COLOR. ABOVE RIGHT: SQUEAK RIGGED WITH NULLS, NO BONES. 

recognize the advantages of shape 

animation in given situations, but I try to 

steer away from it as much as possible. I 

prefer pipelines to be clean, flexible and 

open, with an escape route available should 

something go horribly w rong, requiring 

immediate attention. I prefer simple and 

consistent workflows that can be adapted 

to a wide variety of situations, as it's easier 

to troubleshoot problems when there are 

fewer variables to keep track of. It's also 

easier to teach others the method when 

time is short and their experience is limited. 

While working many late nights and nearly 

m issing several deadlines due to shape 

animation limitations and risks, I decided 

to look for alternatives that fit very specific 

criteria: 

1 FLEXIBILITY - It must work w ith m ost 

toolsets in XSI w ithout painting 

p rojects into a corner and allow for last 

m inute changes w hile preserving work 

already completed. 

2 SIMPUOTY - It should be easy to set up, 

maintain, and edit, have bi-directional 

workflow, and must be easy to understand 

and explain to others not familiar with it. 

3 CONSISfENCY - Should use workflows 

already common in other areas of 

the software, allowing animators to jump 

between tasks without having to continu-

ally think which buttons to push or which 

workflow to use. 

4REUABILITY - Should be able to w ith­

stand heavy use without breaking down, 

but have an escape route should it fail. 

I spent time analyzing several tools, 

such as the lattice, curve deformation, and 

skeletons, to drive deformations, but each 

had drawbacks. Some were easy to imple­

ment but difficult to use. Others were fun 

to work w ith, but not reliable or predictable. 

In any event. it opened my eyes to the pos­

sibi lities of not only what could be done, 

but also w hat could possibly go wrong at 

the worst possible time. Sometimes it's 

more important to know what NOT to do. 

I f irst tried the lattice, as it was familiar, 

simple, and flexible, but soon dismissed 

it as not being di rect enoug h. Shape 

animation o ffered direct manipu lation 

of the sur face. To get that same level o f 

control with a lattice requi red increasing 

subdivisions until it became too dense. 

Next I tried another popular alternative: 

skeletons. Using single-bone chains, I'd 

apply geometry as an envelope to the 

skeleton and manipulate the bones to 

d rive the deformations. It offered flexibil­

ity, as I could place bones into a hierarchy 

and create complex motions with minimal 

effort and retain the use of powerful 

animation tools such as constraints. I 

could also reduce manual labor by not 

having to move each point on the surface 

individually. Instead, I could assign a bone 

to a g roup of points and assign variable 

weighting to prevent the surface from 

buckling or crimping. Basically, the bones 

became handles. However, there were 

problems w ith controlling skeletons, as 

each bone was accompanied by a chain 

root and an effector, which would over­

r ide animation applied directly to the bone 

if they were m istakenly keyed. Simple 

systems were predictable, but as the bone 

count grew and animation became com­

plex, unexpected motions started to arise 

and were often difficult to track down and 

correct. Two steps forward and one step 

back, but it did produce some positive 

results . With a little more investigation, I 

came up w ith my final solution - nulls as 

envelope deform ers. 

The "nulls as d eformers" method takes 

a little t ime to set up, but has many 

advantages over the shape animation 

workflow w hile fulfilling my four goals 

of being simple, reliable, flexible and 

consistent. 

First, it's flexible in that it's based on 

skeletal envelopes and transforms. Multiple 

points on the surface can be assigned to 
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AN ALTERNATIVE TO 5HAPE. .. 

a null or multiple nulls, then weighted for 

smooth or rigid transition, depending on 

the situation. If the underlying surface 

needs to be modified or swapped, the 

envelope operator can be muted while 

the changes are made. Animation will be 

preserved because it resides on the nulls, 

not the geometry, so no fear of lost work 

- an asset when working under pressure 

and tight deadlines. It's also useful as an 

animation exchange system, as motion can 

be created on a low resolution surface, then 

transferred to a higher resolution surface (or 

vice versa) by applying and weighting the 

envelope accordingly. 

Second, the system is simple; it consists 

of only nulls and an envelope operator with 

its associated weight map, which keeps 

the learning curve fairly small. Assigning 

nulls to the surface is a simple matter 

of painting weights using the weight 

brush. Nulls can be placed in any type 

of hierarchical arrangement desired and 

manipulated using basic transform tools 

(or advanced tools such as constraints). 

For deformation control, nulls can be 

distributed where needed - more nulls in 

areas of detail, and fewer where li ttle or no 

movement occurs. If problems arise, there 

are fewer places to investigate, which 

reduces the troubleshooting process to a 

quick inspection- a time saver. 

Third, the system is consistent, as nulls 

are animated and edited using the same 

tools as for other objects. That is, the nulls 

are animated using the basic transform 

tools, and data appears the same in 

the animation editor and mixer (when 

inspecting clips and sources) as Function 

Curves with familiar position , orientation, 

and scaling values along a time line. This 

allows animators to jump between tasks 

without thinking about which tool they 

must use. Also, precise control is always 

available, as values can be edited numeri­

cally in the text edit boxes accompanying 

the editors and property pages. 

Finally, the system is reliable. It's rare 

for t ransform tools to become corrupted 

in a tired scene. If geometry fails or 

becomes corrupt, it can be replaced w ith 
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NULLS USED TO DEFORM FACIAL FEATURES FOR LIP SYNC ANIMATION 

another object. If the envelope operator 

fails, it can be reapplied and reweighed, 

or plotted as shapes so work can con­

tinue. As mentioned before, animation 

is not lost because it resides on the nulls, 

not the surface. 

NULLS AS DEFORMERS 

The basic premise is that nulls wi ll act 

as handles, which can be manipulated to 

deform the surface, much like grabbing 

the points themselves, only there will be 

fewer nulls which have more degrees of 

freedom. To set up, the system requires 

a surface to be deformed and a set of 

nulls. The nulls should be placed around 

the surface where it is intended to be 

deformed. For example, on the head of 

a character, most of the nulls w ill be lo­

cated arou nd the face (cheeks, lips, eye 

brows, nose, etc ... ), w ith a few around 

the ears and throat, and none around the 

top and back of the skull. See example 

figure above. 

A successful system w ill have nulls 

arranged in a hierarchy where parent 

nulls can be mani pulated to control 

several child nulls that control smaller 

regions of the surface. For example, a 

null at the base of a mouth (jaw), but 

more child nulls distributed around the 

lips. When the jaw null is rotated, the lip 

nulls move with it in unison, but the lip 

nulls can sti ll be manipulated individually 

with their offsets relative to the jaw. One 

advantage of using nulls in this fashion 

is that the parent of a particular branch 

can be easily rotated or scaled to create 

wrinkles, folds, puffiness, pinching, or 

puckering with minimal hassle as trans­

formations are propagated throughout 

the branch. 

So, how does this system work? Let's 

walk through a few simple examples. 

First we'll use a simple sphere and a few 

nulls to demonstrate the concept, and 

then move onto a more complex example 

involving the cloth simulator. 

1 Get > Primitive > Surface > Sphere. 

2Get > Primitive > Null. (Create seven 

nulls.) Leave one null at the origin 

named "n_nulls"; make the other nulls the 

children. 

3Translate one null along each of the 

six axes of the sphere until they reside 

near the sphere's surface. 

4 Put the chi ld nulls into a group by 

selecting them and pressing the 

"Group" button on the Main Control 

Panel (MCP for short). Label the group 

"G_nulls" in the resulting Property Page. 
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6With the sphere selected, Animate > 

Envelope > Set Envelope, then pick 

the "G_nulls" g roup in the explo rer when 

prompted. Right-dick to end Picl( mode. 

7Select and translate nulls individually as 

desired. Set keys by activating a Trans­

form tool, then pressing 'K' to set a key. 

As you manipulate the nulls, notice 

how rotating and scaling the nulls can 

create folds and wrinkles. Adding nulls and 

placing them closer together can create 

sharper creases. 

THINGS TO TRY: 

- VOL scaling mode on the individual nulls. 

- Rearrange the null hierarchy to get different 

behaviors when transforming. 

- Draw a NURBS curve and use Animate > 

Path > Set Path to put a null on the curve. 

-Constrain a null to another animated 

object in the scene. 

- Use the bounding volume constraint to 

constrain the nulls to an implicit sphere/ 

cube for cheap obstacles or deformations. 

The main point, as you can see, is this 

workflow retains full capability to put the 

null on a path, constrain it to another object, 

or even make it drive other objects within 

the scene, all while deforming the surface. 

The default weight distribution of the 

envelope fits the nulls fairly nicely, too. Of 

course, tweaking will be required for more 

complex geometry such as a character's 

face, but you get the idea. 

SIM ULATION: 

The most frequent use of the "nulls as 

skeleton" method will be to create anima­

tion f rom scratch by employing the nulls 

as handles to the surface, but there are 

other important uses. One example is 

cloth simulations. The advantage is that 

the nulls can be constrained to the points 

on the cloth surface so when the simula-

XSI TUTORIAL 

SOME SIMULATION ENGINES ONLY PROCESS POINTS ON SURFACES 
RATHER THAN THE SURFACE ITSELF, LEADING TO ERRORS 

tion is run, the nulls will inherit the motion 

generated by the cloth simulator. W hen 

semi-desirable resu lts are reached (or at 

an impasse), the motion can be plotted to 

the nulls and used in the animation mixer 

to tweak or enhance the results. For ex­

ample, to nail a portion of the cloth down, 

localize undulation of the surface, or cor­

rect mistakes made by the simulator such 

as penetrating obstacles. The workflow Is 

generally the same as before, but with the 

added step of using the object-to-cluster 

constraint to constrain each null to a point 

on the cloth surface. Creating a null for 

every point on the surface is not neces­

sary, as the weighting supplied by the 

envelope operator will fi ll in some of the 

void between nulls. A ll that matters is that 

nulls exist where the fabric deforms. 

1Model > Primitive > Surface > Grid. 

Name it "fabric" in the resulting Prop­

erty Page. This w ill be the cloth. 

, Simulate > Force > Gravity. Keep default 

Lvalues. 

3With the fabric selected, Simulate > 

Goth > From Selection to apply the 

cloth simulator. 

Jl Model > Primitive > Surface > Sphere. 

"+This will be the doth obstacle. Reduce 

the radius to a value of 1.5, and then translate 

it just below the fabric. 

5With the fabric selected, Simulate > 

Environment > Set Obstacle. Pick the 

sphere, then right-dick to end Pick mode. 

6 Press Play to watch the simulation. 

Increase the frame range if necessary 

for full results. 

The fabric should collapse around 

the sphere In a wrapping fashion. Pay 

special attention to the top of the sphere 

as it penetrates the fabric. See example 

in the figure shown above. We'll use the 

"nulls as skeletons" method to correct 

this problem. 

7Go to the first frame of the scene, then 

select the fabric. 

8 Model > Primitive > Null. This null will be 

copied and distributed across the fabric, 

so keep It visible in your schematic view. 

9With the fabric selected, run the 

M L_Dupllcator script (which can be 
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found at www.mantom.net in the down­

load area). In the popup d ialog, activate the 

"Constrain" option (fhis constrains the nulls 

to the points on the fabric). Click OK, then 

pick the null created in the previous step. 

After a few seconds you'll see the nulls 

appear on the fabric surface. However, 

they may be a bit large in the viewports, 

making selection and viewing difficult. 

10With the child nulls selected, 

press <ALT + ENTER> to open a 
multi-PPG. Click the "Null " tab and set 

the size to 0 .25. Then press <ENTER> to 

accept. This should reduce the display of 

the nulls to a more manageable size and 
is preferable to scaling the nulls w ith the 

Transform tools. 

11With the nulls still selected , press 

"Group" on t he M aster Control 

Panel (or use Edit > Create Group). Name 
the group "G_nulls" in the resulting 

Property Page. 

12 Right-click on the G_nulls group 

created in the previous step, 

and choose "Select members" from the 

context menu that appears under your 

mouse cursor. 

130 pen a multi -PPG for the nulls and 

click the keyhole icon in the top 

right corner of the Property Page (next 

to the "x") to keep it onscreen. Go to the 

"Local Transform" tab and whi le pressing 

<GRL>, mark the X, Y, and Z parameters 

for rotation and position. 

14Animate > Plot> Marked Parameters. 

Press OK to accept default values. 

This will plot the motion of the doth simula­

tion onto the nulls as Fcurves. 

151n the multi-PPG, click the "Object 

to Cluster Cns" tab, and then un­
check the "Active" parameter to turn off 

the constrain ts. The nulls are now driven 
by the plotted Fcurves instead of the cloth 
simulation. 

16Animate >Store > Marl<ed Parameters 

- Fcurves. In the resulting dialog, enter 

text edit box. Press OK. This removes the 

plotted Fcurves from the nulls and stores 
them as an Animation Source for use within 

the animation mixer. 

17Create another grid (don't duplicate 

the existing fabric surface), then 

make it the envelope of the nulls by selecting 
the grid, choosing Animate> Envelope > Set 

Envelope from the animation toolbar, then 

pick the G_nulls group to assign the nulls as 

deformers. Right-dick to end Pick mode. 

18With the nulls selected, open the 

animation mixer and click the 

recycle button (circular arrows) at the top 

of the animation mixer. On the empty 
track, right-click and choose "Insert 

source," then pick the "simulation" clip. 

This will reapply the cloth simulation 

on the nulls, which will in turn drive the 

deformation of the 2nd grid. 

Now, let's correct the penetration of 

the sphere. 

19Go to the first frame of the scene. 

'") ~o Select the nine nulls that are in the 
L..; center of the fabric. See example 

above left. 

21 Press <ALT + ENTER> to open a 

multi-PPG. Mark the XYZ param­

eters for local position and rotation. 

22Animate > Store > M arked 

Parameters - Current Values to 

store the current location o f the nulls. 

Name the clip "mid_section" in the re­

sulting dialog, then press OK. 

23Right-click on an empty track in 

the animation m ixer, then load 

the mid_section source you just stored. 

Grab the center (verti cally) of the right/ 

left ends of the clip and drag to resize 
the clip to fit the scene. Don't drag the 

corners, as that creates cycles. 

24Go to the end of the scene and look 

at the penetration of the sphere in 

Now that the nulls are in place, let's 

transfer the motion from the doth simulator 

to the nulls: "simulation" in the Action Name parameter • the viewports. 

~~~- 3~ ISSUE 2 • 
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Notice the sphere no longer penetrates 

the fabric. However, we have a new 

problem as the nulls sit too high over th e 

sphere, creating an unnatu ral look. 

25Reduce the value of the mid sec­

tion weight slider in the animation 

mixer (right side of mixer). Lower the 

value until just before the sphere pokes 

through. 

Press Play to watch the simulation 

again . The cloth should now fall correctly 

over the sphere, but you might need to 

animate the value of the mid_section 

weight slider to fade in so the cloth 

doesn't hang before the cloth falls. If 

it's not to you r liking , simply repeat 

the steps to correct the penetration, but 

move the nulls into better locations to 

create a more conv incing look. If you 

don't like the simulation as a whole, you 

can re-activate the "Object to Cluster" 

constraints on the nulls in a multi-PPG 

and re-plot the motion for further edit­

ing. The motion previously stored from 

the older simulations can still be blended 

with the new simulations if needed. 

A feature that requires mentioning is 

the ability to repeat motions o f the clo th 

seamlessly on a loop. For example, if 

one of the corners needed to flap about 

repetitively in the w ind, motion can be 

p lotted (or manually keyframed) and 

stored as a source, then loaded onto 

the mixer and cycled by d ragging the 

corner of the clip. It can be applied to 

the clo th as a w ho le o r just on a few 

nulls. The cycles can be made seamless 

by r ight-clicking on the clip and using 

the Animation E.di tor to adjust the posi ­

tion Fcurves of the nulls so the fi rst key 

matches up w ith the last. If working 

w ith motion capture data, try the "Fi nd 

Cycles" tool from the clips menu to 

isolate repeating motion automatically . 

Another advantage of the "nulls as • 

deformer" method, in the case of the 

cloth simulator, is the ability to anchor ' 

portions of the fabric as if pinned to 

the f loor o r another object. This is eas­

ily accomplished by storing the g lobal 

positions (not local) of the nulls in a clip. 

When placed on the mixer, the global 

positions w ill overr ide the local positions 

stored in the plotted simulation clips, 

resulting in the nulls si tting still. Option­

ally, the g lobal positions can be blended 

with constrain ts as constraints reside on 

the g lobal t ransform parameters . 

CONCLUSION: 

The "nulls as deformers" method may 

require more initial setup, but it offers 

more flexibility during production than 

shape animation, while providing a safety 

net should things go wrong at the most 

inconvenient moment ... such as w hen 

the director asks for radical changes late 

Friday night just when you're trying to 

head out for the weekend. 

With practice, you'll soon discover 

that rarely do you need as many nulls 

as points on the deformed surface. By 

XSI TUTORIAL 

keeping the system simple, it becomes 

easier to edit your work as it progresses 

and lowers the learning curve for those 

new to XSI that have to jump In at the 

last moment to assist you. If you desire 

simplicity, consistency, flexibility, and 

reliability In your workflow, then consider 

using the "nulls as deformer" method . .;. 

MATT LIND IS A CHARACTER ANIMATOR. TECH­
NICAL DIRECTOR. AND SOFTIMAGE-CERTIFIED 
INSTRUCTOR AND FOUNDER OF MANTOM 
EDUCATION & TRAINING IN CHICAGO, IL. MATT 
HAS VAST EXPERIENCE IN COMPUTER GAMES 
DEVELOPMENT AND HAS WORKED IN A VARIETY 
OF ROLES FOR CLIENTS, INCLUDING WARNER 
BROS., HASBRO/MATTELL, TERRAGLYPH, 
INTEL,VIACOM.PARAMOUNT,DISNEY,ANDMORE. 
MATT IS AVAILABLE FOR ONSITE CERTIFIED XSI 
TRAINING AS WELL AS PRODUCTION WORK. 
IN HIS SPARE TIME, MATT WATCHES I PLAYS 
SPORTS, COLLECTS MUSIC, AND ATTENDS 
EVENING CLASSES IN PURSUIT OF A 2ND 
COLLEGE DEGREE IN ENGINEERING. 
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W
hether you're watching a 

blockbuster movie or a slick 

TV comm ercial. you can take 

it for granted that any 3D content spent 

some time inside a compositing program. 

Rendering out your scenes in a number of 

passes Is the best method for achieving 

professional-looking results. 3D design 

and animation for broadcast TV is quite 

different from its privateer or Hollywood 

counterparts, most significantly in terms 

of budget and time constraints. Big budget 

fi lms have money for 3D companies with 

dozens, if not hundreds, of talented artists 

working days or weeks to complete a shot. 

If you design for television. on the other 

hand, you're quite often on your own, in 

charge of modeling, texturing, animating 

and rendering, all in a fraction of the time. 

LightWave 3D's M atte Objects option offers 

you a solution to quickly isolate different 

objects in your Lig htWave scenes and gen-

~~~a 3~ ISSUE 2 

erate w hatever alpha channels you need to 

composite your renders. Having this ability 

increases your flexibility when working on 

projects or renders of any size. 

I recently completed a job that required 

me to build a nighttime cityscape w ith 

buildings and roofs that are populated by 

large-screen television monitors playing 

various music v ideos. Modeling the city 

and animating the camera fly -throughs 

was fairly straightforward. However, 

I didn't know how close to the project 

deadline I would receive the artist footage. 

With that in mind, I rendered each scene 

in several different passes. To help demon­

strate this process, let's take a look at one 

of the scenes. The image above shows the 

final composite (I"ve traded out the video 

with my cat Buddy, as he's a lot less likely 

to sue me for publishing his picture in this 

magazine). Each scene was broken up into 

THE ABOVE IMAGE IS A FINAL COMPOSITE 
OF ALL THE RENDER PASSES. 

four passes: a sky pass, background pass, 

screen pass. and volumetrics pass. Once 

the animation was completed, I could 

render out every pass except the screen 

pass, since I was still waiting on footage. 

This preparation was essential in meeting 

the project deadline. As I received the late 

footage, I rendered it using LightWave's 

M atte Objects option. 

Before I explain how to set up each 

scene to render, let's take a look at each 

separate pass. just a note: when I refer 

to passes, I"m talking about breaking dif­

ferent objects out of a scene , not surface 

attri butes. Render passes can also refer 

to a beauty pass, specular pass, occlu-

• 
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CLOCKWISE FROM TOP LEFT: SKY PASs- A RENDER OF THE SKYDOME, READY FOR COM POSITING. BACKGROUND PASs- JUST THE BUILDINGS AND MONITORS 

RENDERED. NOTE THE SCREEN IS BLANK. SCREEN PASs- JUST THE SCREEN WITH FOOTAGE ON IT. VOLUMETRIC$ PASs- JUST THE VOLUMETRIC LIGHTS. 

sion pass, etc. I didn 't have that luxury 

on this job. Due to the time constraints, 

I got my final renders close to what the 

creative director wanted and then did 

simple color correction and f inishing in 

After Effects. 

Here's a description of the passes I 

rendered: 

SKY PASS: Simply a render of the 

sky for separate color correction in After 

Effects. 

BACKGROUND PASS: All the 

buildings in the ci ty, as well as the m oni­

tors. Notice that the monitor screens are 

black. Even though the screen pass is 

placed over the monitors, it's best to 

make them black. If we rendered the 

background pass with som ething playing 

on the screens, the screens· edges would 

run the risk of buzzing once the artist 

footage was composited on top. 

SCREEN PASS: Just the monitor 

screens. The artist footage is the "hero" 

in each of these scenes. In television 

speak, that means that it's the element 

to which y ou really want to direct at­

tention. When I composite each scene 

together in After Effects, my goal is to 

make the footage in the monitor really 

take precedence. With that in mind, i t's 

best to render out the footage w ithout 

any harsh light, or too li ttle light pointed 

at it. In the screen pass, I delete all the 

lights f rom the scene file and exclusively 

use luminosi ty and diffuse values with a 

little ambient lig hting turned on to get 

the render pass. The more adjustments 

that I can achieve in After Effects with 

Levels, Hue, Saturation , etc., the better 

off I'll be when the creative director and 

client start making changes. And trust 

me, they will. 

VOLUMETRIC$ PASS: The volumetric 

lights rigged to point at the screens. 

.JANUARY I FEBRUARY 2005 



TOP LEFT- MONITOR.IWO- THE MONITOR OBJECT. NOTE: SCREEN IS BLACK IN THIS VERSION. TOP RIGHT- MONITOR_JUST_SCREEN.IWO- A VERSION OF THE 
MODEL WITH JUST THE SCREEN POLYGON SCREEN RETAINED. NOTE THAT I'VE LEFT ALL THE OBJECTS POINTS AND ONLY DELETED THE POLYGONS. KEEPING THE 
DIMENSIONS OF EACH MODEL THE SAME IS ESSENTIAL. BOTTOM LEFT- MONITOR- MATIE.IWO THE MONITOR MODEL WITH THE SCREEN POLYGONS DELETED. 

BOTTOM RIGHT- EACH OBJECT'S MATIING OPTIONS ARE ACCESSED HERE ALONG WITH ITS MATIE OBJECT ALPHA OPTIONS 

To create the passes there are three ver-

sions of the monitor object: 

monitor.lwo 

to cut an alpha if they ever pass over the 
1 screen polygon. 

attributes to calculate the alpha, Unaffected 

by A lpha, which disregards the object when 

calculating the alpha, and Constant Black, 

which considers the object 100% opaque monitor _jus t_screen .lwo 

monitor_matte.lwo 

moni tor.lwo is the entire monitor model 

w ith the screen polygon changed to black 

(no d iffuse o r lum inosity value). 

monitorj ust_screen.lwo is just the screen 

polygon. I deleted all other polygons in this 

model, but retained the points. I did this ' 

because, although the points don't show 

up in the renders, retaining them keeps the 

dimensions of each model the same. When 

the models are swapped out in the screen 

and volumetric passes, they would shift 

position if the dimensions were d ifferent. 

The monitor_matte.lwo is the monitor 

w ith the screen polygons deleted. Deleting 

these polygons allows for the spotlig hts 

Both the sky and background pass are 

straightforward. They don't requi re any ' when calculating the alpha. I use Constant 

com plex matting. The sky pass is just camera Black because I don't have any transparent 

position data exported as a UghtWave 

.mmf fi le and im ported into a scene w ith 

a huge sphere textured with a sky image. 

The background pass is rendered with the 

monitor screens black and the volumetric 

lights turned off. 

In the screen pass, I turn all objects except 

the monitors into matte objects. To do so, I 

open each object's Properties panel, go to 

Render Settings, activate the Matte Object 

objects in these scenes and I assume that it 

will render a little faster because it doesn't 

have to factor in each object's surface settings 

and textures, only its geometry. If you're 

running Ug htWave [8], as a time saver you 

can also open the Scene Editor, select all the 

objects in the scene, and open the Properties 

panel. Activating the Matte Object option 

then activates it for all selected objects. 

Now let's address the monitors. I want to 

option, and select Constant Black for the alpha 1 see the screens and make sure the spotlig hts 

setting (See Image Above). Matte Objects will ' affect the alpha channel. In the schematic 

color your objects any solid color you choose 

unless you activate one of the alpha options. 

There are three to choose from: Use Surface 

Settings, w hich uses each object's surface 

view, I select each of the monitor objects and 

use the Replace Object command to swap in 

the screen objects. (See image fadng page) 

This is OK, but I still need the monitors to be 
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MONITOR_JUST _SCREEN.LWO. TOP RIGHT- WITHOUT THE RIGHT SETUP THE 

SCREEN PASS WILL COVER THE SPOTLIGHTS ON THE BACKGROUND PASS. 

LOWER LEFT- HERE IVE CLONED EACH MONITOR AND SWAPPED IN THE 
MONITOR_MATTE.LWO FOR EACH. MIDDLE RIGHT- HERE ARE THE TWO ALPHAS. 

THE TOP DOESNT HAVE THE MATTE OBJECT IN THE SCENE TO CUT THE 
SPOTLIGHTS OUT. LOWER RIGHT- NOW THE SCREEN APPEARS TO BE 

BEHIND THE SPOTLIGHTS. 

matte so that the spotlights will appear over 

the screen. If I rendered and composited at 

this point, the screen would cover up the little , 

spotlights in front of them, as shown in iamge 

at top right (featuring my other cat, Slicer). I 

then done each screen object and replace 

the dones with the matte monitor objects, 

remembering to turn Monitor_Matte.lwo into 

a matte object in the Properties/ Render panel. 

Once that's done, the screen renders out and 

doesn't crop the lights. 

The volumetric pass is achieved using the 

same method. A ll the monitors in the scene 

are swapped out with the Matte_Monitor 

object. The other objects in the scene are 

turned into matte objects and all the lights 

except the volumetrics are turned off. Now 

the volumetrics composite over the screen, , 

but seem to come from behind the spotlight 

bodies, not on top of them. 

Well that's it. Plan out your projects in 

advance and see how many different passes 

you can render out. Whatever the job, your 

3D content will benefit f rom some post­

processing and the more objects you have 

isolated, the more exacting adjustments you 

can make. In the world of broadcast design, 

this useful skill can not only affect the quality 

of your work, but also make the difference 

between finishing a job on time or not. 

AARON KENT HAS BEEN 
AN "AFTER EFFECTS 
GUY" IN NYC FOR ABOUT 
FIVE YEARS. HE USED 
TO BE A CARPENTER, 
BUT GOT TIRED OF 
SHEETROCK AND BACK 
PAIN. HE HAS RECENTLY 
STARTED TRYING TO BE A 

' LIGHTWAVE GUY: HE WORKS DURING THE 
DAY FOR A DESIGN AND ANIMATION COMPANY: 
WWW.SHIFTLESSDREAMS.COM. HE WANTS TO 
CREATE A SHORT ANIMATED FILM IN LIGHT­
WAVE. IF HE EVER GETS TO IT YOU'LL FIND IT AT: 
WWW.SHIFTLESSDREAMS.COM. HE CAN ALSO 
DRINK A LOT OF BEER. 

JANUARY I FEBRUARY 2 005 



BY GREGORY GLEZAKD5 

RESULT OF THE FINAL HDR IMAGE ON A 3D RENDERED MODEL 

INTRODUCTION 

A
cquiring a High Dynamic Range 

(HDR) panoramic photograph of 

a live set, and then using it as a 

source of illumination for Image-Based 

Lighting (IBL) in a 3D application, is an 

efficient way to composite rendered com­

puter g raphics elements into live action 

scenes. So, if you ever want to insert 3D 

objects into live action plates, your best 

bet to properly light and render them in 

your 3D program is to go on location 

and shoot an HDR photo of the area sur­

rounding the set where your object w ill 

be inserted and use that HDR image for 

Reflection, Di ffuse, and Specular lighting. 

With this tutorial, we are going to learn 

how to photograph and create a 360° 

panoramic environment using a digital 

camera and a reflective chrome mirror 

ball, which is the most trusted and widely 

used method for acquiring High Dynamic 

Range data from a set for Image-Based 

Lighting use in any 3D application. We'll 
also see how to use off-the-shelf software 

to construct the HDR image from our 

photos. and we"ll learn how to deal w ith 

the problems that come along with this 

technique. 

FIG. 1- REFLECTION, DIFFUSE, AND SPECULAR 
LAYERS USING AN HDR IMAGE 

• 
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METHODOLOGY 

Now, there are many ways to shoot a 360° 

panorama. Some of the most common are: 

I. Using a camera with a 6- 10 mm ftsheye 

lens attached 

2. Using a camera and a mirror ball 

3. Using a camera and a tripod only 

4. Using a PanoScan camera f rom 

www.panoscan.com 

5. Using a SpheroCam HDR camera from 

www.spheron.com 

The last two methods are, of course, 

the best and most exotic. This means 

that they can produce the HDR photo 

for you almost automatically. ready for 

direct use in your 3D software, but prob­

ably at a price not suitable for personal 

or home use. Using fisheye lenses to 

produce panoramic photos is a faster 

way than using mirror balls, but then 

you have to use an expensive lens to 

minimize aberration and light degrada­

tion across the w hole image and find a 

lens that can capture more than 180° at 

once. The cheapest and most awkward 

method is using only a camera on a 

tripod and shooting bracketed exposure 

sequences. Problem is, you'll end up 

with a huge amount of photos that you 

have to stitch together, and in multiple 

exposures. Ouch! 

There are more options for capturing 

HDR data from a set, like using special 

custom-built cameras that can capture 

both still and animated images, w ith five 

exposures at the same time printed on 

the same frame. 1...:\ter, using a special 

program. they can extract the data from 

each frame and create an HDR image 

sequence. As far as I know, those are 

for very specific projects and not for 

the average day usage. If you want 

more information in general about HDR 

photography, you can visit Master Pau l 

Debevec at: www.debevec.org and from 

there, learn all there is about this g reat 

invention. 

So, this leaves us with the most tried, 

trusted , and cost-effective method for 

TUTORIAL 

FIG. 2-A 1 o· CHROME STEEL MIRROR BALL BEARING 

creating HDR environment photos; using 

a camera and a mirror ball. These mir­

ror balls are actually chrome steel balls, 

mostly used as ball bearings, and come 

in different sizes. They can be anything 

between 2 to 20 inches in diameter. Usu­

ally, 2 to 10 inch balls have the best pos­

sible sphericity and diameter tolerance, 

thus producing the most distortion-free 

photos (As shown in Fig. 3 above). They 

are cheap and can be found in many 

stores selling ball bearings and similar 

par ts. A famous one is the McMaster-Carr 

www.mcmaster.com; do a search at that 

page for Ball Bearings. You'll find all the 

possible sizes available. They ship their 

p roducts worldwide. Of course, any kind 

of ball that has reflective p roperties can 

be used; Christmas balls, Chinese chime 

balls, etc. Remember that they have to be 

clean, without d rawings, decals, or colors 

on them. and they must be as spherical 

as possible. 

This technique has good news and bad 

news. The good news is that the mirror 

ball is cheap, can be found anywhere, and 

can display perfectly at least 320° of the 

surrounding environment. The bad news 

is that the camera- and maybe you, the 

photographer - will be visible inside the 

reflection of the environment on the ball. 

Also, we'll get pinched areas in our photo. 

To fix this, we have to shoot the ball twice, 

the second time 90° from either side of 

the original camera position in relation to 

the ball. This way we'll be able to produce 

a full 360° panorama, insread of a partial 

panorama (See Fig. 4 on next page) that 

we would have if we were shooting only 

one side of the ball. This is useful if you're 

also going to use the HDR photograph for 

reflection passes, where the environment 

will be seen on your 3D model as a reflec­

tion. You wouldn't want to see you rself 

or the camera on that reflection, nor the 

seam of a partial panorama. But, if you're 

only shooting for Diffuse or Specular light­

ing. you can get away with an incomplete 

panorama, and the camera visible in the 

photo, as well. In this tutorial, we'll create 

a full 360° panorama in angular (light 

probe) and spherical format, and also see 

how to convert that, or anything else, for 

Diffuse or Specular usage only, if that's all 

we need. 
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HIGH DYNAMIC RANGE. .. 

METER AND TWO HOMEMADE BALL BASES 

~rt~a ~t~ ISSUE 2 

' EQUIPMENT 

To shoot HDR images w ith this 

technique, all we need is a camera, 
1 preferably a digital one because they're 

more forgiving on mistakes, and, of 

cou rse, a mirror ball. Ideally our mirror 
ball will be a 5" to 10" chrome steel 

ball bearing, depending on how much 

the horizon and above. In Fig. 4 , we can 

see a camera tripod that has a tilt meter 

(spirit level) and two mirror ball bases, 

which I created myself w ith the help of 

a blacksmith friend. The big one, which 
is about 3 feet in height, is for full 360° 

capture. The small one is for environ­

ments in which all we want is the upper 

hemisphere (hori zon and above) and we 

, don 't care what's below the horizon , like 

when we want to place a 3D object on a 

table or product stand. 

These bases are constructed easily, es­

pecially if you know how to do welding. 

If you, like me, don't have a clue, you 

can always visit your local blacksmith 

and ask him to build one for you. Re­
member to show him the mirror ball so 

he can understand its weight, in order to 

create the proper balance for the base. A 

common diagram for a base, which is 3 

feet in height and could hold a 7 to 10 ki­

logram mirror ball, can be like the one in 

, Fig . 5 (Facing Page Top). Using a design 
like this, the ball can properly stand on 

the base without problems. Also, the arm 

is curved in such a way as to minimize 

its presence in the reflection on the ball. 

The base's sole should weight at least 

2/ 3 of the weight of the ball, and with 
the extended arm, should equal the ball 's 

weight. If possible, ask him to create a 

holder hole on the base to fit the arm 

inside, so you can remove it for easier 

transportation. Remember to also tell 

him to create a small curvature at the tip 

of the base's arm for the ball to sit and 

balance properly (as shown in Fig. 6 on 

facing page). 

zoom we have on our camera, because Other things we might need on set 
the farther away we place it from the • when taking photographs (see Fig. 7 
ball , the easier it will be to erase it later 

from the photo. Also, it wou ld be best if 

we have a steady t ripod for the camera 

and a base for the mirror ball. Without 

facing page) are a cleaning cloth for the 

mirror ball , and perhaps a pair of thin 

plastic g loves, like those used by dentists, 

so we don't leave fingerprints on the 
the tripod and the base for the mirror ' balrs surface. A measuring tape can also 
ball, we'll be limited on how to set up be helpful. Remember to fully charge 
our photo session; we definitely have to 

, place the camera on something steady, 

like a table, and the ball on something 
that doesn't obscure the area under it, 

or else we'll get a panorama only from 

your camera's batteries and take extra 

batteries with you on set. Also, a remote 

control for the camera would be nice, in 
order to minimize the physical interaction 

w ith it during the photo session. 

• 



(TOP) FIG. 5- INTENDED DIAGRAM OF A 3 FEET BASE FOR HOLD­

ING A MIRROR BALL 

(CENTER) FIG. 6- HOLDER HOLE TO FIT THE ARM'S BASE. BEND 

ARM TO MINIMIZE ITS PRESENCE. CREATE A CURVATURE AT THE 

ARM'S TIP, TO FIRMLY HOLD THE MIRROR BALL 

(BOTIOM) FIG. 7- MEASURING TAPE, SMALL CLEANING CLOTH, 

CAMERA'S REMOTE CONTROL, EXTRA BATIERY, AND PLASTIC 

GLOVES FOR WHEN ON SET 

TUTORIAL 
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HIGH DYNAMIC RANGE. .. 

THINGS TO REMEMBER 

The most important thing to remember 
when shooting an HDR panorama outdoors 

is to be fast, especially when you're going to 
shoot from two different angles, as we are, 
and the light is natural. This means that the 
time from when we start shooting the ball 

from the front to the time we finish shoot­
ing from the side should be the minimum 

time possible. That is because if we stall the 

process somehow, the lighting conditions 
are likely to change. Oouds may appear and 

hide the sun, or the opposite. A lso, if shoot­
ing at a sunrise or sunset, the lighting at that 

time is rapidly changing. Another thing to 
remember is that if there are strong winds 

on location and trees around that area will be 
seen on the reflection, and eventually in the 

HDR image, those trees will be blurred, since 
they would blow in the wind and appear in 

different poses on each shot we take. So. 
remember to consult the local weather when 
you're planning for an outdoor shoot. 

NOTE: Capturing a bright sun and sky is tricky 
and needs careful planning, but, that's beyond 
the scope of this tutorial and we'll disregard it. 

You can learn more about this matter, at this 

Web site: http://wwwkt.usc.edu/graphics/ 
skyprobes/ . If the lighting on location is artifi­

dal, like in a studio environment, we don't care 
for the above issues and can take all the time 
we want; at least, the time the production is 
gMng us for the shooting to take place. 

Now, in order to create an HDR image, 
we need multiple Low Dynamic Range (LDR) 
images. In order to do that, we take simple 

photographs of the same subject in mul­
tiple exposures. A usable number of photos 
would be anything between 3 to 40 different 
exposures. Of course, w ith only three pho­

tos, our HDR image would have very limited 
light range information. On the other hand, 
with 40 photos, it would be very hard and 
time consuming to create an HDR image 
w ith the HDR Shop. Most digital cameras 
have the ability to take up to five different ex­

posures automatically when you hold down 
the capture button. This is called "bracketing 
exposure." Though it can't capture enough 
variations of the lighting conditions, it can 
still be used successfully if we already know 

HO~~ ~fi ISSUE 2 

FIG. 8- PLACE THE BALL AND ITS BASE NEAR OR AT THE CENTER OF THE AREA YOU WANT TO CAPTURE. 
MAKE SURE THERE IS ENOUGH SPACE AROUND THE BALL, FOR THE SECOND go• SIDE SHOOTING 

the light range our CG model w ill receive, 
and we shoot according ly. For this tutorial, 
we want to create a rather full HDR image, 
so 10 to 12 photos of different exposures are 
all we need for a decent image. 

Speaking of different exposures, we don't 
necessarily mean taking photos with different 
diaphragms (F-Stop) each time. Actually, the F­

Stop is better set to the highest possible value 

our camera permits and left there throughout 
the photo session. That's because at the high­

est number, we get the best and most dear 

focus of everything in the scene. Besides, 
most digital cameras, especially those with 
built-in lenses, don't have that wide of a range 
for their diaphragms that we'd like to use for 

an HDR image. The camera I'm using for this 
tutorial has the F·8 as the highest possible 
F-Stop, which Is not a good top diaphragm 
for a camera. If you're using an SLR camera, 
your lens probably has a much higher F-Stop 
number; set it there and forget it. 

No matter the maximum F-Stop of your 
camera, there's no problem at all, because 
we can achieve the different exposures by 
altering the shutter speed instead. This way 
we can use speeds from 1/ 16000 sec to Full 
1\J\anual Shutter Control and vary them in 
small in-between increments. Assuming we 
have all the necessary equipment collected 
and ready to use, let's go on location and start 
our HDR shooting session. 

SETTING UP ON LOCATION 

Once on location, we choose to place our 
base and mirror ball at the center of where 

the 3D elements should appear in the final 
composite, or if that's not possible, at a place 
near the live shooting where we can capture 
similar environmental information (see Fig. 8 
above). Now, in theory, the ideal position for 
the camera would be so far away from the ball 
that by using an alien-ultra-super-high tele­
photo lens to frame it, the ball would capture 
the entire .360° environment at once and with 

zero perspective distortion. But in practice, this 
is impossible, not only because there is no such 

lens, but also because no matter what lens we 
have, we may not be able to place our camera 
where we want it, especially if we're shooting 
indoors. Also, since there is no physical mirror 
ball that can reflect its surroundings .360°, we 
have to photograph the ball twice, the second 
time 9J0 from the first camera position in rela­

tion to the ball. For that, we have to make sure 
there is enough space around the ball to place 
our tripod with the camera as shown in Fig. 
8. After we place the mirror ball's base at the 

most ideal spot, carefully use the gloves to po­
sition the ball on to the base. Use the deaning 
doth to remove any dust or oily fingerprints. 
Then, place the tripod and the camera in front 
of the ball; at first, position the lens at the exact 
same height as the ball; use the measuring tape 
to find it. Also, use the tilt meter to mal<e sure 
it's level with the horizon. 
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FIG. 9- TAKE NOTICE OF THE DISTANCE BETWEEN THE LENS AND THE MIRROR BALL. THE CAMERA LENS AND THE 

MIRROR BALLAREATTHE SAME HEIGHT FOR THE SECOND go• SIDE SHOOTING 

Now. the distance to place the camera 

f rom the ball depends on the camera's 

mega-pixels (MP) and its lens, the size of 

the ball, and, of course, the area. If you have 

a good zoom lens, place the camera as far 

away from the ball as the surrounding area 

permits, but try to keep the ball filled with at 

least half of your frame. Don't go too far or 

the ball w ill be very small inside the frame 

and we'll waste much needed pixel resolu­

tion, and don 't go too close or we'll get less 

reflected surrounding area on the ball, plus 

we'll end up with a huge camera on the 

HDR environment image that could be hard 

to erase afterwards. Taking consideration 

for all the above, we position our tripod in 

front of the mirror ball. Then, using the mea­

suring tape, w e notice the d istance between 

the camera lens and the mirror ball, as 

shown in Fig. 9. Measure the distance from 

the lens to the lower end of the mirror ball 

as it sits on the tip of its base. We'll use that 

distance to properly position our tripod and 

camera 90° to the side of the ball, so that we 

get framing as similar as possible f rom our 

second time, shooting from the side. For this 

tutorial, that distance was 9 I em. 

To capture the LOR images, I'm using 

an 8.3 MP Olympus C8080WZ digital 

camera, w hich has 3264x2448 pixel size. 

Practically, for an HDR panorama that will 

be used for Diffuse and Reflection lig hting 

FIG. 10-THE FRAMED MIRROR BALLAS SEEN FROM INSIDE THE CAMERA'S LCD VIEWFINDER 

on a CG element, 1500x 750 in Spherical 

Aspect Ratio is good enough. We can use 

any digital cam era w ith 4 M P and above, 

though by using a camera with lots of pix­

els, we have the advantage of "wasting" 

the extra pixels by placing our camera 

farther away from the ball and framing it 

in a way that the usable remaining pixels 

are about ISOOx 1500 for the ball. This 

way, when building the HDR image, i t's 

easier to erase the camera. Fig. /0 shows 

the fram ing of the ball, as seen from the 

camera's LCD viewfinder. If your camera 

can show aiding guides on the viewfinder, 

use them for easier framing and make 

a no te of how you frame the ball w hen 

shooting from the front to match that 

f raming later, from the side view. 
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FIG. 11- THE 12 EXPOSURES FROM THE FRONT VIEW OF THE BALL WITH THE EQUIVALENT SHUITER SPEEDS 

SHOOTING THE BALL 

On location, we have nice weather w ith 

scattered clouds and a bright sun. Fortunate· 

Jy the w inds were low. Nevertheless, we'll do 

the shooting at a fast pace. First, by quick 

trial and error tests, we determine our high· 

est and lowest shutter speed numbers. We 

shoot pictures w ith various shutter speeds, 

in order to figure out what our Min and Max 

settings w ill be. For this shooting , 1/2500 sec 

is the fastest and 1/ 1.3 sec the slowest time 

the shutter remains open. So, working from 

fastest to slowest, we start our shooting from 

the front side of the ball. Since we want 12 

exposures, the in-between increments for 

the shutter speed are the following: 

Photo 01: 1/2500 (fastest shutter speed) 

Photo 0 2: 1/1250 

Photo 03: l/640 

Photo 04: 1/320 

Photo 05: 1/160 

Photo 06: l/80 

Photo 07: 1/40 

Photo 08: l/20 

Photo 09: 1/10 

Photo 10: 1/5 

Photo I I: 1/2 

Photo 12: 1/1.3 (slowest shutter speed) 

As you'll notice, we walked our way down 

the speeds by dividing each setting in half un­

til we reached the slowest setting. This works 

fine for our case, and in most cases; also, it's 

an easy way to remember the in-between set· 

tings for when shooting from the side view 

later. In general, we should mal<e a note on 

~~~ ~t¥ ISSUE 2 

12- REPOSITION THE CAMERA go• TO EITHER SIDE OF THE BALL, FOR THE SECOND TIME 

paper of the speed settings we'll use, because 

they must be identical for both the front and 

side views of the shooting. 

As soon as we finish shooting the ball from 

the front. we relocate the camera and the 

tripod to 90° on either side of the ball (see 

Fig. 12). We'll use the distance from the ball 

Your best bet for not moving the camera , we measured before to properly position the 

during shooting as you change the shutter 

speed, and also for taking the photo, is to use 

the remote control for it. This is because each 

' different photo of the ball has to be exactly on 

top of the other, or else blurring and ghosting 

will be seen in the final HDR image. But, fear 

not! This is not a critical factor, as later we'll 

use Photoshop to correct the different photos 

to match one another exactly. Needless to 

tripod and use the LCD viewfinder to frame it 

from the side, the same way we had it from 

the front view. Then, we repeat the same pro­

cess as before and capture 12 shots with the 

exact same shutter speed settings, like those 

of the front view shooting. Fig. 13 shows the 

12 exposures of the ball, this time as they were 

captured from the side view. 

say, if you accidentally move the tripod some- After finishing shooting the ball from the 

how, you'll have to start the shooting of that , front and side views, and before we pack 

side over again from the beginning. In Fig. 

11, you can see the 12 exposures of the ball's 

front view and the according shutter speed 

increments. Though I'm standing behind the 

ball almost 5 feet away, it catches my reflec­

tion as well. I should have gone farther away 

or hidden behind a near tree. Not a big deal; 

we can erase ourselves from the reflection the 

same way we'll erase the camera. 

everything and leave, we have to take a few 

reference photos of the set. Though this has 

nothing to do with the making of an HDR im­

age, it will help a whole lot w hen building the 

30 scene for our object; especially for when 

placing the CG lights. So, take pictures of the 

set from various locations, making sure you 

get a snapshot of everything around the ball. 

If you're in a studio set, make sure you pho-
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FIG. 13- THE 12 EXPOSURES FROM THE SIDE VIEW OF THE BALL WITH THE EQUIVALENT SHUITER SPEEDS 

F4: 1~ . 

FIG. 14-THE 12 LAYERS OF ALL THE 'FRONT' PHOTOS, STACKED ON TOP OF EACH OTHER IN ONE IMAGE 

tograph the artificial lighting rigs and also the 

items, if any, around the area of where the 

ball was placed. Make a sketch on paper of 

the position of the artificial lights if the shoot­

ing is in a studio set and marl< their type and 

intensity. If it's an outdoor set, make a note 

of the time of the shooting and the weather. 

Also, if your 3D object is to be inserted on 

film or video footage, write down the type of 

the camera and lens for each different shot. 

Now, we can call it a wrap and go back to 

start building the HDR image from all those 

LOR images we shot. 

PREPARING LOR IMAGES 

First thing to do is to download all the 

pictures from the camera to a hard disk. To 

organize things a bit, we can create three di-

rectories: ·'LOR," "HDR," and "Reference." In­

side the "LOR" directory, we create two more 

directories called "Front" and "Side," in which 

we place the LOR photos of the ball. Since 

all the photos get their names automatically 

from the camera, it can be helpful to rename 

the UFront" and "Side" photos to something 

more recognizable, like "Front-0 I" for the fast­

est shutter speed photo ( 1/2500), "Front-02" 

for the next and so on, up to "Front-12" for 

the last photo with the slowest shutter speed 

( 1/ 1.3). The same applies for the "Side" view 

photos, this time with names lil<e "Side-0 I" up 

to "Side- 12." In the "Reference" directory, we 

can put all the reference photos we got from 

the set and in the "HDR" directory, we will put 

the images generated from each step we do, 

until we have our final HDR image. 

Now, we'll use Photoshop to make sure 

that each mirror ball photo is exactly on top 

of the o ther, and then cropped to l<eep only 

the ball. If we are certain that the camera or 

the ball wasn't moved at all during the photo 

1 session, we can skip this and go directly to 

HDR Shop and do the cropping there. It's 

easier to mal<e sure everything is ol<ay with 

the photos in l'hotoshop, since we have 

more tools for editing and cropping images. 

Besides, most of the time during the photo 

session, most likely the camera has moved 

just a bit from shot to shot, especially if we 

didn't use a remote control. 

Open Photoshop and load all the "Front" 

LOR images. Select the last one, which should 

be the "Front-12" photo - the brightest and 

most washed out photo - and double-click 

the locked background layer to convert it to 

a working layer; name that layer ·· 12." One by 

one, and working in reverse order using the 

Move tool, hold down Shift and left-mouse 

drag all the other photos into the "Front- 12" 

photo. Hold Shift while dragging to make 

sure that each image layer is placed auto­

matically at the center. Each time you drop 

a photo, make sure you rename its layer 

accordingly to the number. For example, the 

"'Front- I I" should be the " II" layer, the "Front-

06'" should be the "06" layer. and so on. We 

end up having all 12 photos in distinct layers 

inside one image, like in Fig . 14. Working in 

pairs - 0 I with 02, 02 with 03, 03 with 04 

and so on - we make sure that each layer 

photo of the ball is at the exact same location 

as the layer underneath. Examine the layer 

"07," which is one where all the details on the 
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FIG. 15-ADDA LEVELS ADJUSTMENT LAYER, TO SEE 
MORE DETAILS OF THE DARK IMAGES 

FIG. 16-- WORKING IN PAIRS, ALL THE LAYERS HAVE BEEN 
MOVED EXACTLY ON TOP OF EACH OTHER 

reflection on the ball can be perfectly seen. 

Find a detail that you know wasn'r moving in 
the set, like a tree trunk, a desk, a building , a 
big rock, or even a mountain. Zoom in to that 
detail and select the first layer: in our case, the 
0 I layer. The first four layers are quite dark 
and the details are hard to see. For that, we'll 
add on top of the first layer an Adjustment 

Layer of a Leve.ls tool, to be able to see more 
of the details of the first layers (as shown in 
Fig. 15 above). When we reach layer 05, we 
can delete the Levels Adjustment Layer, since 

it's no longer needed. So, with the Levels 
Adjustment Layer added, we select layer 0 I 
and examine it in regard to layer 02, to see 
if the first is exactly on top of the second. If 
it's not, we move it until they are identical. 
Most of the time, the movement of each layer 
is only pixels, so we can use the arrow keys 
for it and at the same time, use the mouse 
to d ick on the eye symbol next to layer 01 at 
the Layers panel to hide-unhide the first layer, 
each time ched<ing the progress of the move. 

When we are happy with the first pair of 
layers, we link them together, and then hide 
the one we've just moved; in our case, layer 
0 I. Then we repeat the process for the pair 
02 and 03 layers. This way, we'll end up 
having visible only the last two layers: II and 12. 
All the above layers will be hidden and 
linked together except the last one, and all of 
them will be identically on top of each other 
(Fig. 16). 
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Now ifs time to crop the im­

ages and keep only the mirror 

ball. Make layer 07 visible and 

draw a rectangular marquee 

selection around the ball, just a 

bit bigger than the ball's edges. 
Immediately, place the mouse in­

side that selection and rig ht-click 

to select the Transform Selection 

tool from the popup panel. 

With that, move each side of 

the selection independently and 

position it exactly at the ball's 

edge. Then hit Enter to keep 

the changes to the select ion, 

and select Crop from the Image 

dropdown menu. Normally, the 

resulting image should be a 

perfect square rectangle. We can 

check this by choosing Image 
Size from the Image dropdown 

menu and noting the width and height in 
pixels. If they are not the same, undo the 
last two steps and repeat the Transform 
Selection process, moving accordingly the 

vertical or horizontal edges of the rectangle 
selection, until the cropped image is a 
per fect square (Fig. 17). While checking 
the width and height of the image at the 
Image Size panel, if it's square, resize it 
down to something more meaningful. For 
this tutorial, IOOOx 1000 pixels are good 

enough. 

THE CROPPED IMAGE IS A PERFECT SQUARE 

Last thing to do Is save each layer as a 
distinct file image in a format that HDR 
Shop can recognize, like BMP or TIFF. We 

can do this by selecting one layer at a time 
and pressing ··etri+Shift+S," which is the 
equivalent to the "Save As" command. For 
layer 0 1, we should use a name like "Front_ 
0 1," for layer 02 a name like "Front_02," 
etc. (see Fig. 18 facing page). We work our 
way down from layer 0 1 to 12, and every 
time we select to save another layer, we 
hide the last one. Don't forget to choose 
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the appropriate format each time you save 

a layer, as it reverts to PSD by default. We'll 

end up with 12 BMP or TIFF images of our 

mirror ball from the front view in IK square 

resolution. That's all we had to do for the 

"front" view images of the ball. We have 

to repeat the exact same process for the 

"Side" view photographs (Fig. 19). When 

we finish with them, we can go to HDR 

Shop to build our HDR image from the 

newly cropped images we've just created. 

BUILDING AN HDR IMAGE 

HDR Shop version I is a free downloaded 

application that can create and edit HDR 

images. You can download it at: http: 

I fwww .ict.usc.edu/graphics/HDRShop/ 

download/ Version 2 is also avai lable w ith 

tons of new features, but it's not free. For 

building HDR images though, version 1 is 

more than enough. Let's open HDR Shop 

and at the top menu buttons, click on 

Create and select the "Assemble HDR 

Image from LDR Sequence." A rather 

large panel pops up. First thing to do is 

load our LDR cropped Images we've just 

saved from Photoshop. Oick on the Load 

Images button and a file requester w ill pop 

up; multi-select our entire set of "Front" 

cropped images (Fig. 20). 

Now, we could finish quickly if we used 

the Preset Scale Increments by clicking on 

the " I F-Stop" button, then on the "Gener­

ate Image" button, to create the "Front" 

view HDR image, but this may not work for 

all cases. We have to do this the right way, 

which is to manually input the different f­

Stop settings of each photo independently. 

However, we didn't use incremental F­

Stops for the different exposures when we 
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FIG. 20- THE 'ASSEMBLE HDR IMAGE FROM LOR SEQUENCE" PANEL WITH THE 'FRONT' PHOTOS LOADED 

were shooting and instead used incremen­

tal shutter speeds. How can we input those 

speeds, or how can we convert them to 

F-Stops, since there is a clear F-stop (Abs. 

Stops) field we could use? 

There is an easy way to do exactly that. 

We'll use the Absolute Scale field (Abs. 

Scale), instead of the Abs. Stops, to enter 

numbers produced with the following for­

mula. We divide the fastest shutter speed 

number w ith each and every one of the 

other speeds, starting from itself, which 

gives us the Absolute Scale of I. Then, 
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we divide it with the next speed number, 

which is 1/ 1250. This would be 1/2500 I 1/ 

1250, which gives us 2. This number is our 

second input for the Abs. Scale field. Obvi­

ously, we can forget about the fractions 

and work directly with the denominators. 

We do the same for the third shutter speed 

setting in the row, which is the 1/640, and 

the formula would be 2500/ 640 = 3.9063. 

This is our third input number for the Abs. 

Scale field, for our third photo in the row. 

We do the same for all the shutter speed 

numbers and we get the following: 

FORMULA ABSO LUTE SCALf. 

2500/ 2500 

2500/ 1250 2 

2500/640 3.9063 

2500/ 320 7.8125 

2500/ 160 15.625 

2500/ 80 31.25 

2500/ 40 62.5 

2500/ 20 125 

2500/ 10 250 

2500/ 5 500 

2500/ 2.5 1000 

2500/ 1.3 1923.0769 

This formula is actually based on the fact 

that every double increase in the shutter 's 

speed also increases the exposure (F-Stop) 

by two. Kudos goes to Richard A nnema 

(rannema@splutterfish.com), director of 

Client Relations in SplutterFish LLC, for 

the clearance on this matter, among many 

other things as well. The resulting numbers 

are to be inserted in the Absolute Scale field 

from top to bottom, like in Fig. 2 1, starting 

from number I and descending. This is how 

we convert the shutter speed settings we 

used for our photographs into something 

HDR Shop can work with and recognize. 

By filling the Abs Scale fields, HDR shop 

automatically calculates the Absolute Stops 

values accordingly for our photographs. 

We should leave the Gamma Response 

Curve at the default value of 2.2, which is 

the default value for most digital cameras 

and photographs. When we fill all the num-
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FIG. 21- ALL THE ABSOLUTE SCALE NUMBERS ARE INSERTED FROM TOP TO BOTTOM, STARTING FROM 1 

22- OUR FIRST HDR IMAGES FROM THE 'FRONT' AND 'SIDE' VIEW OF THE MIRROR BALL PHOTOGRAPHS 

bers of the Abs. Scale fields, we can click 

on the ''Generate Image'' button. After a 

few seconds we get our first HDR mirror 

ball image. Save it in the ''HDR .. directory 

we created in the beginning and use the 

Radiance (*.HDR) format with the name 

''MB_Front"; MB stands for M irror Ball. We 

repeat the exact same process with the 

exact same numbers for the ''Side" view 

images and we name the resulting HDR 

image .. MB_Side" (Fig. 22). 

EDITING HDR IMAGES 

The purpose of shooting the .. Side .. 

v iew was to fill in the bad sampling area 

(pinching distortions) of the ''Front'' view 

in order to complete the 360° panorama, 

and to erase the camera from the center of 

the image. For that, we choose "Front .. as 

our primary image and "Side .. as our sec­

ondary image, meaning that we'll use the 

"Side .. image to fi ll in the missing parts of 

the "Front," which w ill be our main image 

for the whole panorama. After all, one HDR 

image is all we want to create. This is not 

necessarily a rule to follow; I've chosen the 

''Front" image as the primary image for the 

panorama, since the Sun looks more inter­

esting in it than in the "Side .. ; it could have 

easily been the opposite arrangement. 

At this point, we can convert the two 

mirror ball HDR images we've created into 

a format more meaningful to our brain and 

eyes, like the Latitude/ Longitude format, 

which maps (converts) the horizontal 

and vertical dimensions into latitude and 

longitude coordinates, like on a g lobe. We 

can do that by selecting each image one at 

a time, and from the top menu under Im­

age- Panorama, we choose the Panoramic 

Transformation tool. A new window pops 

up, w here we can see a "Source Image .. 

• 



• 

Panoo amic Toansfoom 

50U"celfna90 
D..m.tion t::J-

jMB_Focrthdr ::J jNewlmage .:J 
Foo!Mt [J.. FOIIMl 

j M11ooed8al ::J IL~udelt~~::J 
Vfdh: IH:oo Vfdh: 2000 

Hei!# IH:oo Hei!# IH:oo 

30 Rot.aon 
f;i Use Suggested Aspect A olio (2:1) 

None s~ ~ 
Match Pons IJ s._sarrc>~eNx N: 3 

I 
P Use BRalnteopclotion 

At~ay Rot.aon 

\.. 

FIG. 23- THE PANORAMIC TRANSFORMATION TOOL SEITINGS 
FOR CONVERTING THE MIRROR BALLS 

l3 
OK I 

Cancel I 

FIG. 24- THE FRONT AND SIDE VIEW IMAGES AFTER WE SCALED UP THE F-STOP EXPOSURE VALUES 

and a "Destination Image" area. By default, 

the last selected image before we activate 

that tool Is the one at the Source Image 

field and the default-selected format is the 

Mirror Ball , which is what our source image 

is anyway. On the Destination Image, we 

should always leave the New Image option 

activated to minimize accidents, since 

HDR Shop doesn't have a working Undo 

function. Now, in the format field of the 

TUTORIAL 

Destination Image, we'll choose the format 

to which we wish to convert our mirror 

ball. That would be the Latitude/ Longitude. 

Below, we can set a width and height for 

the destination image. Since, our source 

image is square with a 1:1 aspect ratio, 

converting it to this format would get a 

2: I aspect. Normally , we'd want to keep 

the detail of our image intact. For that, 

we can keep the same height and double 

the width, because we can rescale down 

to the original size anytime without los­

ing resolution from the image, instead of 

rescaling up, which would blur the details 

of an image. So, we set 2000x 1000 for 

the width and height, accordingly. Use 

Suggested Aspect Ratio (2: I) should be 

checked. The Sampling value is a method 

of anti-aliasing the transformation process. 

The bigger the number here, the more time 

it takes to complete the process. Actually, 

values more than 5 don't bring any visual 

difference to the image. A suggested value 

for the supersample field for all transforma­

tions is 3. When done setting the fields, hit 

the OK button to convert the mirror ball to 

a Latitude/ Longitude format (Fig. 23). Fol­

low the same process for both the ''Front" 

and "Side" HDR mirror balls. Save the 

newly created HDR images with the names 

"LL_Fronf' and "LL_Side'' accordingly; LL 

stands for Lati tude/ Longitude. Oose the 

two mirror ball images, since we no longer 

need them. 

Now it's a good time to scale up our 

current exposure to a brighter default 

value so we can see our HDR images 

better. We press the numeric "+" button 

four times on each of the two images to 

up the exposure stops four times. We can 

check it by noticing the lower right corner, 

where it displays the current F-Stop num­

ber. After that, we can select from the top 

menu under Image and Pixels the ''Scale 

to Current Exposure" function , or press 

Ctr i+O, which is the equivalent shortcut 

key. Notice that at the lower right corner 

it now says 0 F-Stops. By doing this, we 

don't lose any exposure information; It's 

just for viewing purposes. We do the 

same for both "front" and "Side'' images. 

Then , we save them again to keep them at 

this exposure (Fig. 24) . 
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It's easier now to see that the two images 

are similar but not identical, since they are 90° 

apart. We have to rotate the "Side" image to 

exactly match the ''fronf' image, in order to 

blend them together. The rotate term is used 

here, since we're in a spherical Latitude/ 

Longitude format. There are two ways to 

do this; the easy way and the accurate way. 

The easy way requires that when shooting 

the ball, the two shooting angles, front and 

side, are perfectly parallel to the horizon, 

meaning that the height of the camera when 

shooting was exactly the same for both and 

that the camera was parallel to the ground. 

If that's the case, then we can simply offset 

the "Side" Image to match the "front." How 

much offset should we use? Well, we position 

the camera at a 90° difference between the 

two shootings, which is one quadrant of a full 

.360° panorama. For that, we offset the "Side" 

image by its whole width; for our case, -500 

pixels. The offset has a negative sign, because 

the camera for the "Side" view shooting was 

set to the left side of the ball. If it were set 

to the right side, then it would be a positive 

offset. So, we do the offset using the Image, 

Transform, "Shift w/Wrap" tool and set -500 

in the width field (Fig. 25). 

Now, the two images are almost perfectly 

aligned, but there is a small difference in the 

parallax perspective. That's because the dis­

tance from the ball to the camera lens was not 

exactly the same between the Front and Side 

view shoots. Probably, we could fix this with 

a Perspective Correction tool. but nothing like 

that is available for HDR Shop at this point. 

So, there's not much we can do about it, but 

most of the time the difference is negligible, 

especially If we paid as much attention as 

possible when setting the correct distance 

between the camera and the ball during the 

shooting session. 

That was the easy way. The accurate way 

is finding two identical points in the two im­

ages and using them to rotate one image in 

all rotational axes to match the other. This is 

more accurate, because it rotates the image 

in X-Y-Z space instead of just horizontal or 

vertical, as with the easy way. In order to use 

this way, first we have to revert the ''Side" 

view image to its original un-offset state and 

work with the Point Editor in HDR Shop, which 
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is located at the top menu bar under W indow. 

Then, holding Ctrl down, we can did( on an 

image and add point locators and see their X­

y coordinates on the image at the Point Editor 

panel. For this to work, first we have to locate 

an item that is dearly visible in both images 

and zoom in at almost a pixel level for dear 

and better identification. Then, with Ctrl + left­

did(, we add one point in one image at that 

location we've chosen and another one in the 

other image at the exact same location. We 

need two points per image for this to work, 

and it's better to select points from different 

areas of the image that are separate enough 

from each other (see Rg. 215, previous page). 

The identical locations we choose should not 

include the camera, of course, nor small trees, 

leaves, or anything that might be in different 

location from one image to the other. Ideal 

candidate points can be artificial lights, big 

rocks, windows, furniture, thia poles, or even 

mountaintops. The two points in each image 

have their own X-Y coordinates, which we 

have to write down on paper or in a notepad, 

because we'U need them shortly. The follow­

ing table shows the coordinates for our im­

ages and how we should write them down: 

Front image points coordinates: 

X y 

Point I 

381.4844 

Point 2 

843.5156 

298.5156 

540.4844 

Side image points coord inates: 

X y 

Point I 

895.4844 

Po int 2 

1354.5156 

294.6406 

541.5469 

To perform the rotation, we select the 

"Side" image, and under Image in Panorama, 

we choose the Panorannlc Transformations 

tool. Then we set as the Source Image the 

"LL_Side" image in Latitude/ longitude 

format, and the same for the Destination 

Image, but for a New Image. We can set 

a super-sample number of 3, and then we 

select the Match Points button and clia on 

the Settings button to enter its properties. 

There we input the coordinates we've written 

down from the two pair of points. The source 
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image is the "Side" view image. We 

want to match its points with those 

from the "front" view image. Set 

up everything , like in Fig . 27, clia 

on OK to close these properties, 

then OK to execute the rotation. 

This way, a new "Side" view im­

age will be created and rotated to 

match the "Front" image. Now, the 

"Front" and ''Side" images should 

be as similar as possible. We could 

fine-tune the match between the 

two pictures more by using the 

Panoramic Transformations tool 

and doing Arbitrary Rotations 

on the ''Side" view using small 

values, and on one axis at a time. 

A lot of trial and error can go on 

for this process, so it's up to you 

to judge if that's necessary, since 

it's dependant on how accurate 

the selection of the points was 

and how similar the distance was 

between the camera and the ball 

during the shooting of the two 

sides. For this tutorial, we leave the 

''Side" view rotated through the 

accurate method and twea)( it no 

more. Save it in HDR format using 

a different name; something like 

"LL_Side2" wiU do. 

Sauce mage por.u Match lo por.u 

Peri 1 1895.4844 I~ ~06 ?on 1 1 381.4~4 lzse.5156 

Poirl. 2 11354 5156 1541 54&1! ?on 2 1~3.5156 1540.4~4 

In Image. In Imago; 

ILL_Side.h<i ::J ILL_Frcrth<i ::J 
Aa...mo Format 

I Latlude/LC>n!llude ::J 
~Farnet 
~ILC>n!llude ::J 

Ok Concel I 
FIG. 27- PANORAMIC TRANSFORMATION AND MATCH POINTS 

SETIINGS, FOR MATCHING "SIDE' VIEW TO "FRONT' VIEW IMAGE 

MASKS IN PHOTOSHOP 

Now, it's time to blend the two 

images to remove the pinched ar­

eas and the camera and to create a 

seamless panorama. We'U use Pho­

toshop to create a blaa and white 

image to use as a mask for the 

blending, which wiU happen in HDR 

Shop. To do that, first we will have 

to save an LDR image from each 

of our two "Front" and ''Side" view images. 

Select one image at a time; up the exposure 

two F-Stops to better see details and select File, 

Save as ... from the top menu. This time, save 

the image as a Low Dynamic Image and in a 

format l'hotoshop can read; I used Windows 

BMP. Use a name like "Preview_Front" and 

"Preview_Side" for the two images and in the 

popup window, select Yes to save the images 

using current viewing settings. Load these 

two images in Photoshop and Shift+drag the 

LAYER AND ADD A LAYER MASK TO PAINT ON 

"Preview _Front" image on top of the "Preview_ 

Side" image. We can unlock the bacl<ground 

layer and rename it to ''Side" and also, rename 

layer I to "Front" in order to more easily un­

derstand which image is which. Add a Layer 

Mask to the Front layer and select it (Rg. 28). 

Now, select the Brush tool, and using a blaa 

color, start painting over the camera and the 

pinched area of the Front layer to erase those 

areas and reveal the Side layer underneath. Set 

a white color for a bacl<ground color, so you 
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FIG. 31- THE CALCULATE FUNCTION PANEL WITH THE APPROPRIATE 
SETIINGS FOR THE BLENDING OF THE TWO HDR IMAGES 
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Cancel 

can use it to paint on the mask layer to reveal 

the Front layer, if necessary. By pressing the X 

shortcut button, we can easily switch between 

the foreground and background colors. Con­

tinue painting on the mask layer using various 

brush sizes until you completely remove the 
earner a and the pinched areas, until all you see 

is a ··deaned" image (Fig. 29). Now, select the 

Front 1\1\ask layer and copy-paste it on top of all 

the layers (Fig. 30). Then, Ratten the image and 

save it as a Windows BNIP or TIFF file; use the 

name ''1\1\ask." 

CREATING THE FINAL HDR IMAGE 

Back in HDR Shop, load the "Mask," along 

w ith the "LL_Front" and "LL_Side2" images. 

We'll use the "Calculate" function, located at 

the top menu under the Image tab, to blend 

the two HDR images using the "Mask" image. 

We activate the function and a panel pops 

up. Set the following settings: Image A is the 

uFront'' vievv image, Images B and D are the 

"Side" vievv, and Image C is the "Mask." The 

Destination Image should be a nevv one, as 

usual, and the default operation that will do 

the blending is the: A· C + B ·( I-C) (Fig . 31). 

Hit OK and voila! We get a nevv HDR image 

out of the two previous Images, deaned of 

bad sampling areas and the camera. If we're 

pleased with the result, we can convert this 
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FIG. 32- THE FINAL HDR IMAGE, IN TWO DIFFERENT FORMATS; LIGHT PROBE AND LATITUDEJLONGITUDE 

new image, in probe (angular map) format 

through the Panoramic Transformations tool. 

Remember to set the resolution at IOOOx 1000 

pixels, since that was the default mirror ball 

image size we used. If the spherical (Latitude/ 

Longitude) map is all we want for our HDR 

image, we can keep this new HDR image 

as it is now and probably rescale it down to 

1500x750 pixels (Fig. 32). 

BEYOND THIS TUTORIAL 

Most of the time, our final HDR image up 

to this point will be okay. But, there may be 

times where further editing should be ap­

plied, probably because of a bad or wrong 

setup on set during the photo session. With 

Photoshop, we can 't edit HDR images di­

rectly at their full 96-bit depth, and HDR Shop 

has no paint capabilities, but we still might 

need to fix certain areas of the image. 

So, we need other applications with paint, 

edit, and done stamp capabilities for HDR 

images. My personal favorite is the ldruna 

Software Photogenics HDR program (http: 

I / www.idruna.com/ downloadwindows.html). 

It is not free, but if you're serious about HDR 

editing, I strongly suggest buying it. With it, 

we can use its Gone Stamp tool to retouch 

areas on our HDR images that the blending 

with a mask in HDR Shop did not fix, or 

simply paint in full 96-bit depth. There is a 

30-day full feature trial version available for 
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download. A neat feature is the ability to ··go·· 

down in low F-Stop values of our HDR image 

- way lower than we could capture on set 

during a photo session - and re-paint lights 

to give them brighter intensities. Also, we can 

use masks created in Photoshop to isolate 

certain areas on our HDR images, like entire 

skies, and apply effects on them like blurring 

or direct color painting. I used Photogenics 

to further edit our final HDR image; in Fig . 

33 (Previous Page), we can see and compare 

the results. I've added a brighter Sun in lower 

F-Stop values, blurred the sky a bit and done­

stamp painted over areas that had some bad 

sampling still visible. 

FINAL THOUGHTS 

As far as I know, HDR Shop is not available 

for OSX yet. Alternative software for OSX is 

"Photosphere·· (http:/ / www.anyhere.com/). 

Also, "Onepaint" is a f ree multi-platform 

program that can paint in full 96-bit depth 

(http:/ /cinepaint.sourceforge.net/ ). 

This tutorial was one of the many ways for 

NewTek 

creating High Dynamic Range panoramic 

images. These images can be used in most 

3D rendering applications available today for 

Image-based Ughting, in order to generate 

more realistic renderings of CG models. I 

hope you enjoy this tutorial as much I enjoyed 

creating it. For those of you who want to ex· 

periment, the LDR cropped version of "Front" 

and "Side" view photos of the ball are available 

online at HDRI 3D magazine's Resource page, 

in a single 36MB zip file. Thanks for reading, 

and see you next time ... ~ 
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I 
n this tutorial, we wi ll be modeling a 

Crossbow using Softimage IXSI v4.0 , 

utilizing a variety of XSI's excellent 

modeling toolsets. 

Before we begin, we want to enable 

the headlight display in the camera's 

viewport. (Viewport b) We will do this by 

sing le-clicking on the word Wireframe, 

then selecting Display Options. When 

the Property Page opens, scroll to the 

bottom and click on the square next to 

Enable Headlight. You can now close the 

Property Page by clicking on the X in the 

Proper ty Page window. This wi ll enable 

us to v iew the shadowed parts of the 

object. You can now sing le-click on the 

word W ireframe (in the camera view) and 

hit the S key to switch to Shaded mode. I 

wi ll split my view up between the camera 

view, user view, and the right view, but 

you can use a quad view if you like. 

OK, now lefs begin by going to the 

Model Panel (shortcut key I) and clicking 

on Get >Primitive>Polygon Mesh >Cube. 

Enter 4 in U, I in V, and 4 in Base. Now, se-

FIGURE 1 

teet the second to first polygon (as shown 

in Figure /) using Raycast mode (U key), 

and right-click select Extrude A long Axis. 

(Note: If you do not get a context menu 

when right-clicking, you probably have 

Extended Component Selection enabled 

in the Master Control Panel; if so, click 

on Select in the Master Control Panel and 

uncheck Extended Component Selection) 

Enter 10 for the Length value, as well as for 

the Subdivs value. Click on the Transform 

tab, single-click on the green divot next 

to X. hold the left mouse button down, 

and drag the divot into the Z divot. What 

this does is create an expression. You can 

close the Expression Editor Property Page 

and enter . I in X; y ou will notice that the 

Z value wi ll change as well. If you are 

getting a pinching effect, you wi ll want to 

uncheck Transform Per Subdivision. Now 

enter -120 in Rotation X, then in Transla­

tion. enter 10 for X andY. (You can use the 

previous expression method here as well 

if you like.) Enter 30 for Z, and hit Shift 

+ A to center the object in all v iewports. 

You should now have something that 

resembles Figure l. 

BY WILL MENDEZ 

The face of the extruded polygon 

should still be selected. Hit Shift + Z, hold 

down the left mouse button, and drag a 

region around the tip of the bow. Rig ht­

click on it and select Extrude along the 

axis again, Enter 3 for Subdivisions and 

1.9 for Length, click on the Transform 

tab, and enter 60 for Rotation on X. Hold 

down the CTRL key and select the poly­

gon face next to the tip we just rotated. 

(Figure3) Right-click select Bridge Poly­

gons, close the Property Page, and center 

the object in all views (Shift+A). Switch 

your Right viewport to the top view and 

hit the Y key for Polygon Selection mode. 

Select the left half of the original cube 

object (Figure4) and hit Delete. Hit the 

spacebar, then in the Model panel, click 

on Modify >Poly. Mesh and select Sym­

metrize Polygons. Hi t the A key to center, 

then E for Edge Mode. Select an edge in 

the middle of the cube. Right-click select 

Edge Loop Around Corners, then select 

the edge adjacent to the one you already 

have selected; this should automatically 

select all the edges around the center of 

the cube. Hit Esc then Delete. 

FIGURE 2 
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FIGURE 3 

Hit the U key and select the center 

polygons at the back of the cube, then hit 

the V key to translate the faces back by 

pu lling on the Transform Manipulator in 

the Z direction. (Note: if you do not see 

the Manipulator, you will have to enable 

it on the Master Control Panel >Trans­

form Panel) Enter 6.0 for the Z Values 

on the Transform panel. hold down the 

CTRL key, and click on the polygon to 

the right and left of the center polygon. 

Hit V to translate, then the Alt key to 

move the t ransform pivot toward the top 

center polygon. (figureS) Now, hit the X 

key to scale and drag downwards on the 

Y Man ipulator unti l the value is around 

1.13 in the Transform panel. Hit Esc, then 

select the center 

polygon and right­

click select Extrude 

Along Axis. Enter 

3 for SubDivs, click 

on the Transform 

tab, then enter 10 

in Translation Y and 

uncheck Transform 

Per Subdiv . Next, 

hit E to go into Edge 

Select mode and 

select the six edges 

from the top of the 

Crossbow. (figure6) 

Right-click and 

choose SubDivide 
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Edges Evenly and enter 3 for the value. 

Go back into Raycast mode, select the 

top and bottom polygon minus the 

center ones (Figurel) using the Ctrl key 

to add to your selection and right-click 

Extrude Along A xis. This will be our 

channel for the Arrow. 

Select the outer two top polygons in 

the front of the Crossbow·s head and hi t 

the Period key. This will repeat the last 

command. Enter 7 for the Length, 6 for 

Subdivs, click on the Transform tab, and 

enter .317 for X and Z scaling and 57 

for X Rotation. Now, select the bottom 

two polygons opposite of the top one 

that we just modi f ied and hi t Delete. In 

the right v iew, hit the Y key and drag 

a region around the two top tips of the 

extruded faces. (Fig ure8) Hit Shift and 

the + key to expand the selection until 

you·re at the base of the extrusion, and 

then right-click select Symmetr ize Poly­

gons. Select the Y -axis in the Property 

Page for Plane Normal; the sym metrized 

polygons should now be welded to the 

bottom base of the Crossbow. 

We wi ll now go back into the construc­

tion history by clicking on the Selection 

button In the M aster Contro l Panel and 

expanding Extrude Op [2] 2X . Click on 

FIGURE 9 

FIGURE 11 

Extrude Op [4] and enter 64 on X for a 

more rounded look. In the right view, hit 

the Y key and drag a region around the 

four ti ps of the extruded polygons and 

then right-click select Bridge Polygons; 

now, select the inner middle polys of the 

new Bridges selection and hit the Period 

key. In your right view, select the bottom 

points by using the T key and dragging a 

region around them. (Figure9) Right-click 

and choose Collapse Components. Still in 

the right view, hit f. and select the Edges 

of the extruded par t of the handle w here 

the body meets the bow. (Fig ure /0) Hit 

Shift + D to subdiv ide edges and enter 

6. Whi le you're still in Edge mode, drag 
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FIGURE 12 

FIGURE 14 

a region from the same extruded area to 

the length of the body (Figure II) and hit 

the Period key. Leave the default value at 

2. Select the four polygons on each side 

of the neck area of the bow, and in Ray­

cast mode, hit V to translate. Right-click 

select Local mode. Unselect COG in the 

Master Control Panel, then d rag on theY 

Manipulator (Figure l2}; both sides should 

now expand outwards. In the right v iew. 

hit the T key, then tag every second line 

of points. (Figure 13) Hit the V key to 

translate, right-click select Global mode, 

then translate upwards to resemble a 

g rip. Hit Esc, then Spacebar. You can 

always hit the + key to change the SubD 

level of your object 

to show how i t w ill 

look in SubD mode, 

then - to return it 

back to its default 

SubD level. You can 

make adjustments 

to the g rip as you 

see fit. 

Now, select the 

adjacent face on 

the front of the 

g rip, which is at an 

angle in Raycast 

mode, (Figure 14) 
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FIGURE 17 

FIGURE 19 

• 

and hi t Delete. Se­

lect the two edges, 

(Figure 15), and then 

right-click 

Weld 

select 

Boundary 

points and edges. 

In E.dge mode, 

select the edges 

below the grip and 

hi t shi ft + D. Leave 

the values at 2, then 

in Raycast, select 

the top and bottom 

polygons nearest the 

FIGURE 18 

grip (Figure 16). Right-click select Extrude 

Along Axis, then click on the Transform 

tab in the Property Page and enter .265 

for the X and Z Scale values. In E.dge 

mode, select the two center edges on 

the front of the top polygon that we just 

extruded so that they are one polygon 

face, then select the Center polygons on 

the front and back of the top extruded 

faces. Hit Ctrl + d to duplicate, hit the X 

key, then right-click select Local mode. 

Now center your mouse in the middle 

of the manipulator so that It shows XYZ, 

then begin to drag the manipulator with 

the left mouse button so that you can 
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see the faces scaling towards the center. 
(Figure 17) Hit Esc, right-click and select 

Bridge poly gons. You can also collapse 

the four poi nts near the new bridge 

object. (Figure 18) 

In the rig ht viewport , go to the Model 

panel and click on Create>Curve>Draw 

Cubic by Cvs, now begin to draw a 
curve from the bottom extruded face. 
(Figure/9) Next, select the bottom ex­

truded face in Raycast mode, right-cl ick 

select Extrude A long Curve, and select 
the cu rve. E.nter 8 for the Subdivs and 

.9 fo r the X and Z Scaling. Now, select 

g.gt/~a ~~ ISSUE 2 

the polygon face, which is at a slant 

above the newly extruded object and hit 
CRTL+D then X. To scale inwards from 

the center o f the polygon, hit Esc, and 

rig ht-click select Extrude Along Axis. 

E.nter 4 for SubDivs, .8 in X and Z scal­

ing, then -II for X Rotation. This wi ll be 

you r trigger. (Figure 20) You can adjust 

the Rotation or Translation of the trigger 
to your liking. 

In Point Selection mode (T key), select the 
end 12 points of the handle and hit X, right­

click select Global and COG, then drag on 

the red manipulator to make the butt of the 

Crossbow handle w ider. Now, select the 

two polys at the butt of the handle, right­

click and Extrude Along Axis. and enter 8 

for Length. In Point mode, select the last 

six points of the butt, then hit X and scale 

inwards from the center of the Manipulator 

to make the butt of the Crossbow smaller. 

We'll now select the last three polygons 

from the top of the Crossbow's handle 

and hit C to rotate them. Right-click select 

Local, then hold the Alt key and drag the 
center to the middle of the first polygon 's 

edge. (Figure21) Rotate on X by dragging 
on the X Manipulator to lift the back of the 

handle upwards. (Figure22) 
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SCREEN SHOTS CAN BE DOWNLOADED AT WWW.HDR13D.COMIRESOURCES/ 

FIGURE 26 
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In the right v iewport, hit E, then 

left-click and drag a region around t he 

upper back and top edges, Deselect the 

Top Center and hit Shift + D (Figure23) 

to subdivide the edges. In Raycast 

mode, select the top four polygons of 

the newly subdivided faces and hi t V . 

then right-click select Local mode, click 

on the Z Transform Manipulator, and 

drag towards the front of the Crossbow. 

(Figure24) In Edge mode, hit the E key 

and d raw a region around the butt of the 

Crossbow, then hit Shi ft and + to grow 

the selection unti l you reach the trigger. 

Now right-click and choose Bevel Com­

ponents. You can experiment with the 

slider to see how the Bevel relates to the 

edges with different values. In this case, 

we will leave it to the default options. 

(Figure25) 

THE FINAL CROSSBOW 

We'll now create the string by select­

ing both the faces of the inner curve of 

each side of the bow using the U and 

CTRL keys. (Figure26) Right-click select 

Bridge Polygons. Now select the edges 

of the newly created sting , right-click 

select Subdivide Edges, and enter 10. 

Now with the entire Crossbow selected, 

click on Selection in the Master Control 

Panel and scroll all the way down to 

Extrude OpZ. Expand it, then double­

click on Extrude Op and move the slider 

on the Translation Z rotation unti l the 

sting meets the top of the Crossbow 

channel. You can now continue making 

modifications to the Crossbow to your 

liking. Hopefully, with this tutorial you 

gain a bit of knowledge on some of XSI's 

Modeling workflows. Texturing and Rig ­

g ing the Crossbow is a different story for 

another tutorial. -

WILL MENDEZ IS AN XSI 
GENERALIST I ZEALOT 
LIVING IN CANADA, HE IS 
THE XSI BASE AMBASSADOR 
AND PRESIDENT/FOUNDER 
OF THE XSI USER GROUP 
IN MONTREAL WILL HAS 
ALSO DONE CONTRACT 
WORK FOR SOFTIMAGE IN 

TECHNICAL SUPPORT AND QUALITY ASSURANCE 
DEPARTMENTS. 

BIG UP TO CHINNY AT SOFT. 
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PHOTOSHOP CS 
AND 

LIGHTWAVE [8] 
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I 
have always been fascinated with the fine art 

potentials of using Photography and 3D. The most 

obvious application of the two mediums would be 

to use photographic images as surface maps for 3D ob-

jects. These images, of course. can be scanned or shot 

wi th any digital camera. Because I strive for my work 

to be somewhat unpredictable in terms of the applied 

technique, I chose to use photography as the basis of 

the final piece and integrated into it 3D objects created 

in LightWave [8]. My intention was to create an image 

that is not only surrealistic, but aggressive in nature. So, 

let's discover how photography, 3D sculpturing, and 

Photoshop are used to create "'Sticks."" 

• 
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Let's look at the images that were used 

to create the final piece (Figures 0 I - 05). 

The f inal piece resulted in an inter­

esting biomorphic female nude, bu t 

all good portrai ts should have a back­

g round that allows the figure to stand 

out p rominently. In this case, I wanted 

i t to be aggressive in nature, but at 

the same time, not conflicting with the 

main subject. Using elements that were 

all unrelated proved not only to be a 

challenge, but it also taught me how 

to view every thing as potential source 

material in an effort to consolidate the 

v ision. I began by using LightWave [8] 

Modeler to create a ser ies of root-like 

protrusions. 

SfEP 1 

To begin, a 2x2 meter plane is created. 

(Figure 06) 

SfEP2 

The plane needs to have more ge­

ometry from which the roots can be 

extruded, so it is subdivided (Shift-D). 

(See Figure 07) 

PHOTOSHOP TUTORIAL 
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STEP 3 

Next, the plane is subdivided again so 

that it has 16 polygons; in add ition, the 

subdivision surfaces are applied by hitting 

the Tab key. This, in essence, is applying 

addition points to g ive the roots a rounded 

and organic feel. In addition, this extra ge­

ometry is ideal to have when the displace­

ment map is applied later on. Now that we 

have the foundation for our roots, let's go 

create them. (Fig ure 08) 

STEP4 

Activate the Magic Bevel and hit the N 

key. First of all, notice that there are blue 

circular handles in the center of each poly­

gon. By clicking and dragging them out, a 

series of beveled shapes has been created 

that resembles roots. (Figure 09) 

STEP 5 

We have some options available to 

make modifications to the beveled shape. 

In figure 10, the scale in the numeric panel 

has been set to 100%. This allows the width 

of the beveled shape to match the w idth 

of the polygon that it was created from. 

A smaller percentage will taper the tip 

more drastically over time. The higher the 

percentage, the more subtly the taper w ill 

take affect over time. Figure II shows the 

results of the scale set of 96%. 

~~~a ~~ ISSUE 2 I 
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PHOTOSHOP TUTORIAL 

SfEP 6 

I like to work in perspect ive view so 

that I can have some control as to how 

the root takes shape in 3D space. After 

apply ing a third root, as shown in figure 

12, another option is app lied in the 

numerical panel. This time it's the Spin 

command. This simply g ives the artist 

the abili ty to twist all o f the shapes ap­

plied in the Magic Bevel's command. A 

twist of 16.3 degrees was applied in this 

example (Figure 13). 

SfEP 7 

Figure 14 shows the completed model 

with several roots twisting in every di rec­

tion. The goal here is to create 3D shapes 

that resemble twisted sticks. This will be 

used to integrate into the background of 

our final piece. 

SfEP8 

Next the shape is copied (Ctri-C) 

from its layer and pasted (Ctri-V) into 

another layer. It is ro tated 180 degrees 

and positioned so that the tips of the 

roots overlap. This is all that is needed 

for now. (Figure 15) 
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STEP9 

After the objects are sent to Layout, 

the Camera Screen Proportions are set 

to closely resemble the slender format 

of the final piece. F9 is applied to get a 

quick view of how the shape w ill look. 

(figures 16 &. 17) 

STEP 10 

Next, Displacement and Bump map tex­

tures are applied to the surface. Figure 18 

shows the settings that were used. Figure 

19 shows possible options for applyi ng 

texture maps created in Photoshop. 

CREATING THE NUDE 

Now that the roots are completed, let's 

create the biomorphic nude abstraction. 

STEP 1 

The morphing process began with 

a female nude that has been photo­

graphed against the sculptured stones in 

joshua Tree National Pari<. In Photoshop 

CS, the layer is duplicated (Ctri-J) and 

transformed (Edit>Free Transform) as 

shown in figure 20 with its blend mode 

set to Lighten. This has already started 

the blending effect. 

~~~a 3D ISSUE 2 

FIGURE 19 SURFACE TEXTURES APPLIED TO 3D OBJECT 
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STEP1 

With further experimentation, the inter­

mediate result resembled figure 21. 

STEP3 

The same technique is applied using 

PHOTOSHOP TUTORIAL 

FIGURE 20 LAYER DUPLICATED WITH BLEND MODE ADJUSTMENT 

the result from Step 2. By duplicating the 

morphed nude and setting its blend mode 

to Lighten so that they blend seamlessly. 

interesting possibilities start to take shape. 

It doesn't look like much yet, because 

masks have not yet been applied. That wlll 

be in the next step . 

STEP4 

With the layer mask applied, all areas that 

are painted black on the mask w ill make the 

areas of the image that it is associated with 

go away. So using the WACOM tablet, 

undesired areas are masked out, leaving 

the result shown in figure 23. 
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SfEP 5 

Next, the top layer is duplicated and 

masked so that the sky in the top right 

becomes prominent again. 

SfEP6 

Next, the image has an overall yellow 

cast, which blends the foreground and 

background elements a little too much. 

The nude needed to stand out on its own 

a little more, so an Adjustment Layer is 

added with a mask applied so that only 

the figure receives the colo r change. 

SfEP7 

To add some interest to the lower por­

tion of the nude, i t is duplicated again, 

rotated, and positioned .so that its cavity 

is positioned over the leg. Next, a layer 

mask is appl ied to reveal the new detai l 

on the nude. 

SfEP8 

Finally, to fu rther .separate the background 

from the foreground an Adjustment Layer 

of Hue &.. Saturation Is applied. The Satura­

tion slider is taken all the way to the left to 

make the image black and white. Notice that 

the advantage of Adjustment Layers is that 

they are provided w ith a mask where its 

effects can be controlled by painting with 

_.......,. CI:J 
-.-.rr-~r:w ~ 

(f'¥1 ----o- Red p ~ 

black or white. Remember, white allows the 

effect to show through and black w ill block 

out the effect. In this example, the Hue &.. 

Saturation is not desired on the body of the 

nude, so black is painted over that region on 

the mask. (Figure 28) 
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FIGURE 28 HUE & SATURATION ADJUSTMENT LAYER APPLIED 

INTEGRATING THE ROOTS 

STEP 1 

Although there is an improved 

distinction between the nude and the 

FIGURE 31 LIGHT STEAKS ARE APPLIED 
TO THE BACKGROUND 

backgrou nd , it sti ll appears a little too 

simplistic, so this is where we add some 

sophistication by composting the 3D 

roots made in LightWave [8] as shown 

in figure 29. Figure 30 shows how layer 

masks are applied to allow the body to 

PHOTOSHOP TUTORIAL 

stay prominent, while the background 

maintains the roots. In addition, the 

Roots layer is duplicated and the Layer 

Blend Mode is set to Hard Light to give 

them a little more drama. 

SfEP2 

Next, the image still has a feeling of 

being too static, so I placed some light 

streaks that were taken as long expo­

sures at night with a Cannon D-60 as the 

camera is swirled around. This created 

some wild kinetic shapes. The Overlay 

blend mode is applied to in tegrate the 

shapes into the background elements. 

Again, masking is used to isolate 

most of its effect to the background. 

(Figure 3 1) 

SfEP3 

In this step, I wanted the body to take 

on a change in color and there are a 

variety of ways to go about this, but 

I chose instead to use the rust detail I 

photographed off of an old water tank 

and placed it in a layer above the nude. 

Next, the blend mode is changed to 
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Color, which simply took the colors in the 

rust image and applied them to the nude 

below it. Once again a mask is applied to 

restrict the effects to the figure. (Figures 

03 & 32) 

SfEP4 

After viewing the current results I felt 

the background could take on a more 

aggressive nature so I placed another 

version of the roots in a new layer over 

the body as shown in figure 33. After­

wards the layer 's blend mode is set to 

Overlay to g ive them a transparent like 

blend with the other textures as figure 

34 shows. 

ADDING THE FRAME 

The current image has all of the basic 

elements needed for its completion and 

later on it will be nne tuned but for now 

let's g ive this image a frame. 

SfEP 1 

The frame that I chose to use was a 

shot of an old weather-torn door. I loved 

the rusted look of the latch bolt because 

it would work well with the use of the 

FIGURE 34 THE NEW ROOTS LAYER BLEND 
MORE IS SETTO OVERLAY 

rusted texture o r iginally used for the 

nude. The door was placed and resized 

so that the latch rested in t he upper por­

tion of the frame. Using the Eraser tool , 

the interior was discarded, allowing us 

to see the figu re inside. Finally, a layer 

mask is applied and edited so that the 

1 

FIGURE 02 ORIGINAL IMAGE 
USED FOR THE FRAME 

root on the left side can appear to be on 

top of the frame. 
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STEP 2 

FIGURE 38 HUE & SATURATION 
ADJUSTMENT LAYER IS APPLIED 

Moving forward, the door layer is 

duplicated (Ctri-J) and filled w ith black 

(Edi t>FIII>Fill with black). Gaussian Blur 

(Filter>Biur>Gaussion Blur) is used to 

soften the edges. because shadows usu­

ally have a soft look to them. Next, the 

layer's Opacity is lowered to around 50% 

so that we can see through it . Finally, this 

layer is placed beneath the door to give 

the appearance that it is lifted in front of 

the figure. (Figure 36) 

STEP3 

At this stage, the image suggests a 

theme of degradation , so to conti nue on 

this path, the rust texture is used again 

to blend w ith both the background and 

the frame. Several layers are used to 

achieve this, and each one is masked so 

that the effect only occurs on the back­

g round and the frame. (Fig ure 37) 

STEP4 

The background areas around the 

PHOTOSHDP TUTORIAL 

roots and figure needed to be desatu­

rated. A Hue &. Saturation Adjustment 

Layer is applied and masked accord­

ingly. (Figure 38) 

STEP 5 

To gain a greater sense of depth, more 

of the 3D roots are applied to the upper 

portion of the frame. Next, a mask is 

applied and edited to allow the f igure to 

remain dominant. (Fig ures 39 &. 40) 
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SfEP6 

Now this is where the background is 
given its own character. At this stage, the 
background is a composite of a variety of 
colors and energetic textures. Two Adjust­

ment Layers are added for the sole purpose 
of neutralizing out the color. The Hue &.. 
Saturation Adjustment Layer desaturates 
the background and the Selective color 
gives some richer density. (Figure 41) 

STEP 7 

It's starting to take shape quite 
nicely, but I added some extra detail 
to the nude. In essence, the original 

morphed nude is duplicated and distorted 
(Edit>Transform>Distort) and its blend 
mode is set to Darken. I only wanted to 
affect a small area, so most of the layer 
is masked out. Figure 42 and 43 shows a 
before and after example. 

~t/~a 3f'i ISSUE 2 
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FIGURE 44 ADJUSTMENT LAYER 
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STEPS 

Figure 44, 45, and 46 are examples of 

Adjustment Layers with masks to not only 

fine-tune the image so that the roots color 

is altered to separate it from the rest of the 

image, but also to deepen the tonality of 

the neutralized background. 

That's it. There Is no rig ht or wrong way 

to create as a fine artist. The bottom line is 

that the product honors the vision of the 

creator. If you experiment regularly, you 

can be exposed to endless possibilities of 

expressing your creative vision. I hope you 

enjoy ed this article. If you would like to see 

more of my work, please visit my site at 

www.chromeallusion .com 

Enjoy. Q. 

STEPHEN BURNS HAS 
DISCOVERED THE SAME 
PASSION FOR THE DIGITAL 
MEDIUM AS HE HAS FOR 
PHOTOGRAPHY AS AN ART 
FORM. HIS BACKGROUND 
BEGAN AS A PHOTOGRAPHER 
22 YEARS AGO AND IN TIME, 
PROGRESSED TOWARD THE 

DIGITAL MEDIUM. STEPHEN HAS BEEN A CORPORATE 
INSTRUCTOR AND LECTURER IN THE APPLICATION 
OF DIGITAL ART AND DESIGN FOR THE PAST 8 1f2 
YEARS. HE HAS BEEN EXHIBITING DIGITAL FINE ART 
INTERNATIONALLY AT GALLERIES SUCH AS DURBAN 
ART MUSEUM IN SOUTH AFRICA, CITIZENS GALLERY 
IN YOKAHAMA, JAPAN, AND CECUT MUSEUM OF 
MEXICO TO NAME A FEW. PART OF HIS EXHIBITING 
WON HIM 1ST PLACE IN THE PRESTIGIOUS SEYBOLD 
INTERNATIONAL DIGITAL ARTS CONTEST. OWNER OF 
BURNS DESIGN, HE TEACHES DIGITAL MANIPULA· 
TION WORKSHOPS IN THE SAN DIEGO AREA AND 
NATIONWIDE. HIS TEACHING STYLE COMES FROM 
HIS ABILITY TO SHARE AN UNDERSTANDING OF 
PHOTOSHOP SO THAT THE STUDENT HAS THE 
ABILITY TO INTUITIVELY APPLY IT TO HIS/HERS 
CREATIONS . 
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BY DEUCE BENNEIT 

SPREADSHEET 
PRCJ..JECT MANAGER 

W elcome ba.ck. I have a different 

type of information to pass on 

this month. There are those of 
us in the CGI industry that work at studios 
as a modeler, texture painter, animator, 
compositor, or any other position. This article 
isn't really for you at this point in your career, 

but it might be later. This is more for those of 
you who plan to hang your shingle out as a 
freelancer or start your own studio. There's 
something very important you must learn, 
and that's what I want to talk you about. 

So, you have managed. 

by some method, to get a 

a budget, then telling you what all is involved. 
Projects always g row; they never shrink. 

The job of producing animation and video 
projects requires many skills. It is not enough 
to be skilled in modeling, lighting, surfacing, 
animating and compositing. You also have 
to be good at estimating, scheduling, pric­

ing, and keeping track of a myriad of details 
involved in the production. Business skills are 
as essential in this business as any other. Most 
small studios like ours can't afford to pay a 
salary for specialty positions like Producers 

the time and space of this article. It arose out 
of the process we used when we were do­
ing physical special effects for movies. We 
always made checklists. This began when 
we did our script breakdown and aided in 

figuring our budgets and lists of expend­
ables, additional manpower and rentals. 

We call all modeled objects, images, 
surface textures, sets, landscapes. and set 
dressings "assets." Generating assets can 

be as much as 70% of a project, so realistic 

estimations of time to create assets are 

critical. It is true of scene cre­
ation, rendering submission, 

prospective client for your 

animation business. You might 

then hear the fabled words 

- "How much will it cost me 

to make a one minute anima­

tion?" What he's really asking 

for is your ·rule of thumb' to 

price his project. At Creative 
lmagineering, in our experi-

CEil is Fun. but: it:•s even more 
Fun when it: •s proFit:able. Ut:ilizing 

and proofing of renders. We 

evolved this over a period of 

about three years and about 

twenty projects. spreadsheet:s could make t:he 
difference bet:ween a proFit:able When we get a storyboard, we 

begin by imagining all the shots 

that are implied by the action 

shown and the reading time of 

the script dialogue, if any. We 

talk these through aloud while 

job and an expe nsive Jesson_ 

ence, the only 'rule of thumb' 

that you can and should 
answer is your hourly rate. Don't understand? 

OK, then visualize this. Picture the amount 
of work it would be to do one minute of a 
logo animation. Just a logo flying around the 
screen with a few moving shapes in the back­

ground. Now imagine the amount of work to 
do one minute of the ba.ttle for Helm's Deep in 

Fe/Jowship of the Ring. Both of these are easily 
classified as computer animation, but wholly 

different amounts of work. When someone 
asks you "How much will it cost me to do 
my animation," the first question you should 

ask is to see a script or storyboard. You can­
not and should not answer with any kind of 
budget without seeing, at the least, a "script 
synopsis." It is from this that you can see what 
is going to be involved in the project. Oients 
have a nasty habit of getting you to lock into 

or Production Coordinators. This lack can 
adversely affect profits and deadlines. 

The way I look at it, you don't make your 
money when you're busting your buns in a 

late-night rush to finish by the deadline. You 
make it when you bid the job realistically, 

allowing for last minute changes and re-ren­

ders. We all have ba.d memories of a job that 
we underbid for one reason or another that 
caused us to lose money instead of making a 
profit. Those are not career builders. 

We at Creative lmagineering, Inc. have 
evolved a technique that aids us in every 
step of a project. from pricing to final 
rendering. that we just have to share. If only 
some of you find this helpful, it will be worth 

timing them each with a stopwatch. Estimating 
the length, in seconds, of each constituent 
piece gives us an educated guess as to the 
running time of the project. 

Next, we list all the assets necessary for 
each scene. Then we consider which of the 
assets we already have. If these assets were 
not generated for the dient at hand, we add 

some development cost for their use. After 
all, these are our work and we have a right 
to benefit from bringing them to the project. 
This also protects us from underestimating 
the production of other assets that may be 
more complex than we could know at this 
point. Then. we guestimate the man-hours 
for creating each asset, or the cost of acquisi­
tion if the asset can be acquired. 
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EXAMPLE SPREADSHEET PROJECT MANAGER 

Scene 

ESiablish silo! of base camp 

man-hours, and 

magic-marker 

completed oper-

E.Siabfish HLrnmer, 4 people around •-Conmandor axnos '-"and- ~"lake weapon system and dos!IOy targer 
ations. One day 

i t occurred to 

me that I could 

Onve H...-.- avet 10 lho _.system 

See men loading sysoom11110 Hummor 

Dnvng shot of Hummor- system covemg t8nan (lhls mrght be tv.o 01 tnree shoes) 

Establish ovet1oolc of valey IMth bn:lge, and Hunvner dnw1g ln:o shot more easily cre­

ate and modify it 

in a spreadsheet 

program. A 

bonus discovery 

was how eas­

ily I could set up 

automatic calcu-

Hummer stopped. men unoad woapon system 

Men setup weapon systom away from Hummer and target bndge 

Shot or weapon system fmg 
Shot of Bridge bemg h.t and destroyed 

Men load system bad< nto Hummer 

Hummer dnves ""'"" 

SCENES REQUIRED 

Next, we evaluate the amount and com­

plexity of the animation required for each 

shot. Again we try to estimate the man-hours 

needed to accomplish each animation. This is 

a bad time to be too optimistic in how fast you 

can turn out a shot. (Remember all the times a 

"simple" animation took twice or three times 

what you thought it would?) 

When figuring the amount of render time, 

don't forget to triple the estimate to cover 

half-res test renders and the inevitable re­

renders. If your scenes involve high overhead 

effects, like Hypervoxels and volumetrics, be 

sure to allow for extra render time. 

We used to organize all these ele­

ments on a sheet of paper divided into 

g raph sections and wrote in times, 

lations to extract data without having to 

grab a calculator. 

Here is the basic setup (Shown Above) 

we use now for production. It is easily 

customizable for whatever you may want 

to do w ith it. 

Now, let's walk through a fictional project 

to see how we develop the estimating chart, 

and how that develops the production chart. 

Oient says that he has a project that will 

be about one minute in length. You ask for 

a script or a storyboard (remember, this is 

prime rule number one). He says that he 

doesn't have a storyboard or script, but he 

does say that he has a basic "storyline idea" 

for the project. You say fine, email it over. 

First thing you do is read through it , and 

make a list of questions. Here is a an example 

"storyline idea' for a military-based project. 

At a base camp, the order comes in 
to deploy the new weapon system. 

The weapon is loaded onto the back 
of a Hummer, and it requires three 
people to use it. 

The Hummer is driven to an area 
that overlooks a valley, showing a 
bridge. 

The weapon is unloaded and set up 
-and is fired, taking out the bridge. 

The weapon is loaded back into 
the Hummer and driven back to the 
base camp. 

NOTES: Only three people can 
carry the weapon, and the mission 
takes place at night. 

OK. A few questions might come up here 

that you will need to ask your client. The base 

camp - is this an established camp or is it 

just a few vehicles? How big is it? How many 

people are here? Things like this. For our 

discussion, however, it's not really necessary; 

we'll just go with the flow. With this "sketch" 

in front of us, let's visualize the sequences 

necessary to tell this story. Here is where 

you can be creative, but remember, you are 

visualizing the work that you will be doing. 

The sequences might come out like this: 

1. Establish shot of base camp 

2. Establish Hummer, four people around it 
- Commander comes up and delivers line 
"take weapon system and destroy target" 

3. Drive Hummer over to the weapon system 

4. See men loading system into Hummer 

5. Driving shot of Hummer with system covering 
terrain (this might be two or three shots) 

6. Establish overlook of valley with bridge, and 
Hummer driving into shot 

7. Hummer stopped; men unload weapon 
system 

8. Men set up weapon system away from 
Hummer and target bridge 

9. Shot of weapon system firing 

1 O.Shot of Bridge being hit and destroyed 

11 . Men load system back into Hummer 

12.Hummer drives away 
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SPREADSHEET PRDJECT. .. 

ASSETS 

Base camp - <ctlts YOilocles(?). bad<ground people 
Hummer-..ehoclo 
weapon system 
bridge 

landscape atOund base<:amp 
landscaoe lot travelng 

landscape 8tOUnd bridge ""' "'""' 
• ruck sack canteen. etc 

OUR ASSETS 

Now, I would enter these into my 
spreadsheet form as shown above right. 

Here I feel it necessary to discuss one 

primary difference between "Movie/Video 
Lingo·· and CGI programs. In a CGI 

program, you load in assets, put things 
together, etc., and save what is called a 
"Scene File." Now, if you have another 

angle that you wish to render in that same 
file, you could move your camera and 
save out another "Scene File'' - however. 
that would, in film terms, be a "Shot" in 
that "Scene." In film terms, a scene is a 
continuous block of storytelling either 

set in a single location or following a 
particular character. The end of a scene is 
typically marked by a change in location, 

style or time. A shot is a continuous block 
of unedited footage from a single point 
of view. Having this in mind means that 
you can break out the assets for a scene, 
knowing that you'll be reusing the same 

assets in multiple shots. 

Next thing that I would do is break out 
a list of assets. 

1. Base camp- tents, vehicles(?), background 
people 

2. Hummer vehicle 

3. weapon system 

4. bridge 

5. landscape around base camp 

6. landscape for traveling 

7. landscape around bridge with river 

8. Men - soldiers and associated weapon, 
rucksack, canteen, etc. 

9. Sky for day, and night 

ASSETS 
Base camp - toots. vellodes(?). bad<ground people 

Es.mated Tmo 

8 
Hunvner vohde 

weapon system 
bridge 

landscape around basecamp 

landscape tor travet.ng 

landscape around bridge wr.h ""''' 

10 

5 

Men - sok118fS ond assoaated weapon, ruck sack, cantoen, etc 10 

2 Sky fa< day and night 

52 man hours 
your rate hem x hour rate r 8$Lma:e for assets 

ASSETS AND TIME FOR COMPLETION 

~ i 
I ~ ~ 8 a: 

9 ~ ~ 0 
f! 11 ! Sceno ~ Dosctlptoon ~ ~ f~ 

Jl ~ u: Est.matod Time 

EstabliSh she< o1 base camp 10 
EstabliSh Hunvner. • peopoe around •-Commander comes up 

3 and delivers lone 'tal<e weapon S'f$!em and desucy ~a~ge~· 
Orne Ho.nvner tNe< 10 the Vo10aPOO sys:em 3 
See men loadong system onoo H""""" 3 
DrMng shot of Hummor <Mth system covenng torrnn (lhrs mght 

5 
bO two"' three shoiS) 
EstabliSh OVCf1ook o1 voiiOy wtn bridge. and Hummor drMng 

3 oniOshol 
Hummer slOpped. men unload """pon sys:em 3 
Men setup weapon systom away from HIJfl'VTlef and target 

3 bndge 
Shot olweapon system flnng 2 
Shot ol Bndge beong too and ciOSUOyed 2 
Men load 5y5tem bade. 1'\10 HLW'M'Ief 3 
Hunvner dnves ~ 10 

SO Seconds 

ESTIMATE ON SCENE RUNNING TIME 

I would put these in a list at the bottom 
of our script breakout. (Shown Above Left) 

This is what we will now use to es­
timate the creation of each asset and 
how long to set up the scenes/ shots in 
question. We tend to use "man-hours" 
as our unit of measure. Here, you can 
see that these values have been put in 

for our estimating purposes. Now, by no 
means is this to be considered accurate 

- this is af ter all just an exercise. When 
y ou use this for your own, be honest and 
accurate for your own estimations. (See 

example Top Right) 

From here, it's easy to set up a formula 
in a spreadsheet to add up our values, 
and multiply it by our hourly rate to get 
an estimation of the cost of this project. 
I always round up w hen reporting to 
the client, just for "slush" - you never 
know w hat wi ll happen in the middle of 
a project, so it's best to try to p lan for it. 
W hen estimating a project before i t has 

been nailed down, by script and story -

board , it's always wise to bracket your 
estimate- meaning, don't say "$2500 ," 
say "somewhere between "$2500 and 
$3500 " - that's what I mean by bracket­

ing your estimate. 

OK - w ith this information all easy to 
see, I'd do a "visual run-thru " with a stop­

watch. What I do is simply close my eyes, 
start a stopwatch, and run the scenes one 
at a time in my head. I w rite the timing 
down in my "estimated run time" column. 
It's here that y ou might discover that your 
"estimated run time" for a p roject might 
be longer than your client's w ish for a 
one-minute animation. If so, then you 
need to tall< about this to see w hat he 

has in mind. Perhaps you have a scene 
or have a thought for an action that isn 't 

needed that could shorten your project 
back down to the running time that is 
mutually agreed upon. This is the benefit 
of having this breakout of the project. 

I went ahead and did that, and updated 
my columns. (Above Lower Right) 
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OUR DETAILS 

Now, providing that the client has now 

g iven the go ahead on our project, we 

modify our spreadsheet just a bit, and turn 

it into our production detail minder. This is 

where this method really shines. Keeping 

track of where you are, what needs to be 

done, and what has been done is of para­

mount importance so that you know what 

is going on ! Here we use color to assist 

in ''at a glance" progress indication. We 

use different colors to help in prioritizing 

certain scenes. We might use a color to 

call out "difficult" scenes, or scenes that 

require more work or specialized tools. 

All of this is at the user's discretion and 

should be worked to your own tastes and 

can even modify on a job-to-job basis. 

An example might be to use one color 

to indicate shots that require animation 

of people. Another might be to flag all 

scenes that require Hypervoxeis, or even 

multi-pass rendering for compositing af­

terward. The things you need to take care 

of are up to you. 

Here are the additional columns. 

(Above Left) 

HOW ONE OF OUR PROJECTS LOOKED 

As each part of the chart gets marked 

off, you have a visual tally of where you are. 

As you get the necessary assets together 

and modeled and textured, you mark that 

off for all the scenes that are involved. The 

next thing is getting the scenes themselves 

set up and ready to go. Then you submit 

the scenes to rendering. Now, this w ill vary 

depending on your setup at your studio/ 

room. We at Creative lmagineering, inc. use 

ButterflyNetRender, so when we submit a 

scene to our BNR controller, we mark it off 

under the ··submit to render"' column. Then, 

the "verify frames" column comes into play. 

If no one has ever told you, you never, 

never render directly to an animation file. 

You render to frames, so you can fix small 

problems, or re-render bad frames. That is 

w hat this column is for. Here, once you have 

verified all frames, no dropped textures, no 

bad polygons, no fl ickering anything, mark 

it complete. Once all this is complete, most 

editing solutions can't handle sequences; it 

needs to be in A VI or some other format. 

Once you have done this, mark it done. 

(Figure above right shows an example of a 

previous project.) 

I hope that you appreciate the simplic­

ity of what has been outlined. Keeping 

track of even a small, project can be a 

large job. In selling your services, .. the 

devil is in the detai ls." Losing track of 

detai ls can cause you to lose profit on the 

job. Doing CGI is fun, but it's even more 

fun if it's profitable. 4i, 

JACK "DEUCE" BENNETT II 
IS A FREELANCE CGI ARTIST 
WITH A BACKGROUND 
IN PHYSICAL SPECIAL 
EFFECTS FOR MOTION 
PICTURES AND TELEVI­
SION. DEUCE HAS BEEN 
WORKING IN THE FILM 
INDUSTRY HIS ENTIRE 

LIFE, AND HAS SUCH MOVIES AS ROBOCOP, 
LONESOME DOVE, AND JIMMY NEUTRON: 
BOY GENIUS TO HIS CREDIT, AS WELL AS 
TV SHOWS LIKE WALKER, TEXAS RANGER. 
DEUCE HAS BEEN USING COMPUTERS SINCE 
HE WAS 9, AND STARTED OFF WRITING HIS 
OWN GRAPHIC PROGRAMS. HE IS A UNIQUE 
COMBINATION OF PHYSICAL KNOWLEDGE AND 
VIRTUAL KNOW-HOW. 
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urfacing a model is a very 

important part of the 3D 

process. Rather than 

spending a g reat amount 

of time modeling details, 

texturing them onto 

the object will not only reduce computer 

memory requirements but also w ill greatly 

improve your character 's appearance (Fig­

ure 1). When it is done right, the texture on 

the model becomes indistinguishable from 

the actual surface geometry. 

Although there are a number of different 

ways to project an image onto an object, most 

of the time UV mapping is used for the precise 

placement of fadal textures. Front projection 

mapping methods consisting of planar, cubic, 
cylindrical, and spherical types are based on 

simple primitive forms. These will work well 

for general overall textures or for simple 

shapes such as the spherical eyeball. 

UV texture maps work well for irregular 

shapes. The texture maps are adhered to spe­

dal points on the object. Since the placement 

of the texture can be assigned to specific parts 

of the object, the g reatest control possible is 

now in the hands of the artist. UV mapping 

can be accomplished in several ways. One of 

the most common is to unroll and Hatten the 

wire mesh and then paint or assign a texture 
to it in an image editing program. When the 

image is saved and assigned to the model, the 
texture conforms to its shape. Some tweaking 

w ill most likely have to be done In order to 

precisely fit the mesh points to the texture. 

~t/1(~ ~0 ISSUE 2 

Another method is to use a special 

3D paint program and actually paint the 

textures onto the object. When the object 

is saved the UV texture coordinate settings 

are saved, along with it, or the texture can 

be saved for spherical mapping. 

0v MJ\PPlNG A H UMAN HEAD) 

The following tutorial will take you through 

the steps for creating UV maps from a head, 

painting the textures in Photoshop, and 

finally importing the textures into your 3D 

program. Since it is very difficult to show 

each step without referring to specific tools 

and menu items, this tutorial will refer to the 

way f'ollaya does UV mapping . Since many 3D 

artists use f'ollaya, it is the logical choice for 

this tutorial. If you are using a different 3D 

program, you should be able to adapt these 

instructions to its methodology by looking 

for comparable tools and menu items. If you 

plan to UV map an entire body that is one 

continuously connected object, then review 

the steps for the head, but follow the guide­

lines in the next section, titled, "UV f'ollapping 
an Entire Body." 

STEP 1 

Start with your low polygon model. There 
is no need to work with a high-resolution 
smooth mesh model, since it only makes it 

more complicated to select specific faces. If 

you are modeling using the smooth proxy 

method (Polygons > Smooth Proxy), you can 

UV map the rough model (proxy mesh). 

Before you make a smooth proxy mesh, 

select the faces that you will UV map for each 
individual part, such as the inside of the mouth, 

eye sockets, nostrils, and the remainder of the 

face. Assign each part a different shader. If 

you want to make a specular map, use a Blinn 

or Phong but not a Lambert shader. Name 

each shader with the part of the face that it 

was assigned to ("inside_nnouth." "eye_sock­

ets," "nostrils," and "face"). If you modeled the 

entire body, you can continue to assign differ­

ent shaders to the various parts. If you already 

have a smooth proxy mesh then just delete it 

and make a new one after you assign all the 

shaders to the low resolution model. 

f'ollake the smooth proxy model and put it in 

its own layer. The smooth proxy mesh has the 

same shaders as the low polygon proxy mesh. 

This means that when you assign the UV 
textures to the shader for the face or any other 

part, the smooth proxy will also receive the 

same textures. Both the proxy and the smooth 

mesh models share the same UVs. Figure 2 

shows the proxy and smooth mesh heads. 

Working with (Figure 2) a low polygon 

count model (left) as opposed to a high 

resolution one (right). The UVs from the proxy 

(low polygon) mesh are shared with the 

smooth (high polygon count) mesh. 

STEP 2 

A duplicate model will now be made 

that can be changed w ithout disturbing the 

original model. This should make it easier to 

• 
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find faces that have a tendency to overlap on the UV map. The UVs w ill 

then be transferred from the duplicate to the original. Create a layer 

for the original head. Copy the head and paste it. Move the duplicate 

next to the original and make a layer for it. Hide the original head. If 

you have modeled an entire person, then duplicate the entire body, 

not just the head. The point count on the duplicate object has to be the 

same as the original one. This means you cannot add more faces or 

points to the original model after making the duplicate one. 

ST EP 3 

Open the Hypershade/ Perspective views. Right-click on the 

shader that you assigned to the face only and pick "Select Objects 

With Material." This will select only the face polygons, not the inside 

of the mouth, eye sockets, and so on. In your perspective view, go 

to Show > Isolate Select > View Selected. Now only the face can be 

seen for the next step and UV mapping. 

STEP 4 

On the duplicate model, select the vertices on the areas that are 

the most complex such as the ears, lower part of the nose and 

nostril , the lips and around eyes. The inside of the mouth, eye 

sockets, and nostril faces are hidden and have different shaders 

assigned to them; therefore, they can be UV mapped separately. 

Each time you select the vertices of a specific area on the face, go 

to Polygons > Average Vertices > Options menu (Figure 3). Ten 

iterations should be enough, but you may have to perform this 

operation several times on some parts; therefore, you might want 

to make a shelf item for this command. 

When you finish smoothing out specific areas of the face, 

select all the vertices of the entire duplicate head and perform 

another average vertices operation. Figure 4 shows the original 

head compared to its smoother duplicate after averaging the 

vertices. Most of the faces are more planar and less complex 

than those of the original head. 

M AY A T U TORIAL 

Polygon Average Vertices Options 
Edit: Help 

Iterations ho I r:=[JI=====:::J 
.__ __ A_ve_ra....;:g;...e __ _.I J._ __ -'Ap-.p....;.ly __ __,l l.__ __ cl_os_e __ ___. 

FIG. 3-AVERAGING THE VERTICES ON THE DUPLICATE HALF HEAD 
TO SMOOTH OUT SEVERE ANGLES ON THE POLYGONS 

Subdivide 
Assign Shader to Each Projection 

Planar Mapping 
Split Polygon Tool Cylindrical Mapping 

Spherical Mapping 

FIG. 5 OPENING THE CYLINDRICAL MAPPING OPTIONS BOX 

Polygon Cylindrical Projection Options 

Smart Fit !;a Automatically Fit the Projection Manipulator 

~ Insert Before Deformors 

Image Center lo.sooo I :;:lo.~so~oo~~! ==:::::1 
Image Rotation lo.oooo I ~ 

Image Scale 11.0000 f lt.OOOO 

D Create New UV Set 

.__ ___ P_ro~je~ct~~~~ ~~~~A....;.p~pl~y--~' 'L----C-Io_s_e __ ~ 
FIG. 6 SETIINGS USED IN THE CYLINDRICAL MAPPING OPTIONS BOX 

STEP S 

Now it is time to use Cy lindrical UV Mapping on the duplicate head. 

Select the averaged duplicate head faces. You can do this easily by 

going again to the Hypershade window, right-clicking on the shader 

that you assigned to the face only, and picking "Select Objects With 

Material". Go to Edit Polygons > Texture > Cylindrical Mapping > Op­

tions (Figure 5). Use the settings shown in Figure 6 and dicl< Project. 

You should now see a cylindrica.l outline around the duplicate head. 

Most of the time you will not have to do any editing using the cylindri-
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SURFA CING A HUMAN MODEL 

cal manipulators, but if you want to scale or move them, locate the 

diamond w ith a 'T' inside it near the bottom of the cylindrical outline 

and click on it (Figure 7). Use the arrows for translating and the cubes 

for scaling. Make sure that in the Attribute Editor (Control A) for the 

cylindrical projection, there is a setting of 180 degrees next to the Pro­

jection Horizontal Sweep. In order for you to see the newly created UV 

map you will have to go to Window > UV Texture Editor ... (Figure 8). 

STEP 6 

As one can see in Figure 9, the UV Texture is somewhat 

distorted in places, stretched on top of the head, and contains 

overlapping polygon faces in some areas. This means that 

parts of t he face w ill now have be UV mapped separately and 

then later stitched together in the UV Texture Editor. In the UV 

Texture Editor, r ight-click and select UV. Draw a selection box 

around the entire UV mesh and mov e it to the side o f the dark 

gray box. In the perspective window, p ress F8 and right-click to 

select Face. Select the faces for the top of the head only and go 

to Edit Polygons > Texture > Planar Mapping > Options. In the 

Planar Projection Options box , select Y -axis for the Mapping 

Direction and click Project. In the UV Texture Edi tor, you r newly 

mapped polygons may look somewhat like those in Figure 10. 

Move these somewhere to the top of the UV Texture Editor 

window. They can be moved anywhere, but be careful not to 

place them w here y ou moved the previously mapped cylindrical 

UVs. 

STEP7 

Next, go back to the perspective w indow and select the neck 

polygon faces. Use cylindrical mapping for these (figure 5). In 

the UV Texture Editor, move the neck faces to the bottom of the 

w indow. Figure It shows the selected neck faces as they might 

appear in the UV Texture Editor and the perspective view. 

STEPS 

Now t hat you have all the face polygons, you can easi ly select 

them by clicking on the model in any of the views and then 

opening the UV Texture Editor. It w ill show the faces laid out 

in three sections. You can select those faces by right-clicking 

in the UV Texture Editor and selecting "Face." Draw an outline 

around the faces in the UV Texture Editor. The faces should 

now be highlighted in your various view windows. In your 

perspective window panel, choose Show > Isolate Select > View 

Selected. This w ill hide everything except for the selected faces. 

To show everything again , choose Show > Isolate Select > View 

Selected. 

Right-dick in the UV Texture Editor and select UV. Scale all the 

separate groups so that they are somewhat proportional. You should 

now have separate UV mapped faces, such as the ones seen in 

Figure 12. 

FIG. 7 THE CYLINDRICAL 
MAPPING MANIPULATORS 

Cylindrical Mapped UVs 
in the UV Texture Editor 

General Editors 
Rendering Editors 
Animation Editors 
Relationship Editors II> 
Settings/Preferences II> 

Attribute Editor ... 
Outliner ... 
Hypergraph ... 

Paint Effects ... 
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FIG. 12 THE SEPARATE GROUPS OF FACES FOR THE 
TOP OF THE HEAD, MOST OF HEAD, AND NECK 

FIG. 13 THE THICKER BLACK LINES SHOW THE SHARED 
EDGES ON THE TOP AND THE REST OF THE HEAD. THESE 

WILL HAVE TO BE MOVED AND SEWN TOGETHER 

MAYA TUTORIAL 

STEP9 

The separate groups will have to be moved and sewn together. In 

the UV Texture Editor, right-click to select Edges and check to see 

which edges are shared between the top of the head and the rest 

of it (Figure 13). Right-click and select UV. Move the vertices of the 

top of the head faces so that they are closer to the corresponding 

ones on the rest of the head (figure 14). 

STEP 10 

Continuing our work in the UV Texture Editor, right-click and 

select Edges. Shift-select the shared edges belonging to the top of 

the head. This will automatically select the shared edges on the rest 

of the head. These are illustrated as thicker lines in Figure 14. In the 

UV Texture Editor, go to the Polygons menu and select Sew UVs. 

This will stitch the shared edges together, as seen in Figure 15. Move 

the vertices that are part of the neck closer to the rest of the face so 

that the shared edges line up somewhat like the ones in Figure 15. 

Shift-select the shared neck edges and go to Polygons > Sew UVs. 
Look for other areas on the head and the inside mouth and untangle 

the overlapping faces. The final UV map should now resemble the 

one in Figure 16. If you find that some faces are clumped together, 

then try going to Polygons > Relax UVs, but be careful because this 

could result in some stretching of your textures. 

STEPll 

Select the entire UV mesh and move it into the top right one unit 

square (Figure 17). You will most likely have to scale the mesh to 

fit into the square. If you plan to UV texture the entire body that is 

connected to the head, then refer to Figure 23. The face UVs will only 

occupy a small section of the one unit square. The next section, titled 

"UV Mapping an Entire Body," explains this procedure. 
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5URFACIN6 A HUMAN MODEL 

Make sure that the head is selected by Object Type in the per­

spective view. It should not be in Component Type, such as when 

you are going to select vertices, edges, or faces. In the UV Texture 

Editor, go to the Polygons menu and select UV Snapshot. In the 

UV Snapshot box, use TIF (if you want to keep an Alpha channel of 

the UV lines) or JPEG for Image Format. Set your X and Y Size large 

enough so that your textures have a high enough image resolution 

- perhaps 1000 by 1000 if you are only texturing the head. Oick the 

Browse button and save your file into your source images folder. 

Oick OK to exit the UV Snapshot box. 

STEP 12 

Before you start painting your textures, you should transfer the 

UVs from the duplicate head to the original one. Make the original 

head visible so that you can see both of them. First, select the dupli­

cate head, and then Shift-select the original head. Go to Polygons > 
Transfer > Options. In the Polygon Transfer Options box , UV Sets 

should be on. Oick the Transfer button. Select only the original head 

and open the UV Texture Editor. You should see the identical UV 

map there. If the duplicate head has a different vertices count than 

the original then you could have problems transferring the UVs. You 

can now delete the duplicate head. 

STEP13 

In Photoshop, open the file that you saved from the UV Snapshot 

box. The TIF or JPEG image will show up with white lines on a black 

background. Reverse this by going to Image > Adjustments > Invert. 
Duplicate this first layer. Use the Magic Wand tool to select only the 

white areas of the top layer. Make sure Contiguous at the top of 
your screen is off. Delete the white areas of the top layer. Select the 

bottom layer and fi ll it entirely with white. Create three more layers 

underneath the second layer. These will be the ones in which you will 

paint the color, bump, and specular image maps (Figure 18). The top 

layer is your template that will indicate the location of your textures 

when they are mapped on your model in Maya. When you paint your 

textures, make sure the appropriate layer is selected. 

STEP14 

Paint the color image map. You can do this in several ways. 

Some prefer to just paint them from scratch while others will 

copy and paste and clone from a photograph. The template layer 

is your guide as far as where the lip, ey e area, forehead, and 

so on are located. Create a bump map. This will just be a light 

grayscale image with most of the lines showing up the strongest 

on the lips. Make a specular map. This is also a grayscale image 

in which the light areas will appear shiny while dark areas more 
matte. You can invert the bump map and work from there. The 

color, bump, and specular images should be the same size with 

the different facial features located in the same areas. Save each 

map as a separate .jpg file. Figure 19 (Next page) i llustrates the 

three maps for only the head. 
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MAYA TUTORI A L 

Bump Map 

STEP 15 

Bad< in Maya, select the low polygon head and bring up both the 

Hypershade and Perspective windows. In the bottom tab of your Hy­

pershade window, double-did< on the Blinn or Phong shader to bring 

up its attributes. Next to color, did< the button, and from the Create 

Render Node window, select the File button under ZD Textures. Open 

the color image map that you saved from Photoshop. This will apply 

the color texture ro the Blinn or Phong shader, and in tum, to your low 

polygon model. 

In the Hypershade window, select the Blinn or Phong shader again 

and in its attributes, click the button next to Bump Mapping. In the 

Create Render Node window, select the File button under ZD Tex­

tures. Open the bump image map that you saved from Photoshop. 

Select the Blinn or Phong shader again and in its attributes, under 

specular shading, select the button next to Specular Color. In the Cre­

ate Render Node window, select the File button under ZD Textures. 

Open the specular image map. 

You will most likely have to make some adjustments to your attribute 

settings for the bump and specular maps, and also in Photoshop to the 

three textures. Before you start, this you will first create a smooth ver­

sion of your head, unless you already have a smooth proxy. 

STEP 16 

If you already have a smooth proxy mesh, it will have the same 

shaders as the low polygon proxy mesh. You w ill not have to follow 

the instructions in the next paragraph. 

Delete the history for your low polygon head to avoid any future 

error messages. Select the head and go to Polygons >Smooth Proxy 

> Options. Use the same settings as seen in Figure 20. The resulting 

smooth head should have the same UVs as the low polygon one. It 

Smooth Proxy Options 
Subdivision Method ® Exponential 0 Linear 

Exponential Smoothing Controls -------------• 

Subdivision levels 12 l r=Q[J:::::====:::::I 
Continuity J1.oooo I r=======D 

!;a Smooth UVs 
Preserve Properties-----------------11 

!;a Keep Geometry Borders 

D Keep Hard Edges 

Keep Map Borders 0 None ® Internal 0 All 

Setup -------------------------------------------
Mirror Behavior ® None 0 Full 0 Half 

Display Settings------------------
Smoolh Proxy Shader 0 Remove 0 Keep ® Transparent 

Proxy Transparency lo.7500 I r======lJI=::::i 
~ Proxy Mesh Renderable 

!;a Proxy Mesh In layer 

62j Smooth Mesh In layer 

Smooth Layer Display ® Normal 0 Template 0 Reference .---------. 
Smooth Apply Close 

FIG. 20 SETIINGS FOR THE SMOOTH PROXY HEAD. 
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SURFACING A HUMAN MODEL 

will also have the same Blinn or Phong shader with its image 

maps as the original low polygon head. 

If you press 6 to see a textured view of your model in the 

perspective window it will show you how well the image maps 

fi t. You should hide the layer with the low polygon model. 

STEP 17 

Whenever you find a crease in the center of your model 

or some of the color textures do not look right, go back to 

Photoshop and make your adjustments. Replace the old texture 

in Maya by selecting i t in the bottom tab of the Hypershade 

window. It w ill be the one with the image. Double-click it to 

bring up the Attribute Editor, and under the image name, click 

the "Reload File Texture" button. Maya will update to the newer 

image. M ake a rendering of the model to see what the textures 

really look like. It is also a very good idea to set up your lights 

right now. One of the first settings that should be adjusted is 

on the bump map. In the Hypershade view, locate the icon for 

the bump map. It will probably have a name like "bump2d 1." 

Double-click this icon and in the Attribut Editor, adjust the 

Bump Value and the Bump Depth. In your Render View, set 

up the IPR (Interactive Photorealistic Rendering) renderer. You 

can now view your bump map adjustments interactively . After 

completing work on the bump map, go back to the Hypershade 

w indow and select the Blinn or Phong shader. In the Attribute 

Editor, adjust the Specular Roll Off and some of the other 

specular settings found under the heading Specular Shading. 

Figure 21 shows a rendering o f the head af ter adjusting the 

various image maps and Attribute Editor settings. 

( UV MAPPING AN ENTIRE BODY) 

After creating the UVs and textu res for the face, continue 

mapping the rest of the body. The face UVs should only occupy 

a small section of the one unit square, leav ing room for the 

body UVs. 

in the UV Texture Editor w indow, right-click and select "Face." 

Select all the head UV faces. Switch to your perspective view and 

go to Edit > Invert Selection. Find the "Show" menu item in the 

perspective window. Select Show> Isolate Select > View Selection. 

This will hide the head and only display the body, making it easier 

to select parts of the anatomy. 

Select the faces of the front of the body, excluding the feet 

and arms (Fig ure 22). Since the body is facing toward you in the 
front view, go to Edit Polygons > Texture > Planar Mapping > 

Options. Next to Mapping Direction , choose "Z-Axis" and click 
Project. This wi ll place a Projection M anipulator in the perspec­

tive view. Your UV Texture Editor w ill show the flattened UV 

faces for the front of the body (Figure 22}. 

FIG. 22 PLANAR MAPPING THE 
FRONT OF THE BODY ON THE Z-AXIS 

AND THE RESULTING UV MAP 

I 



• 

Right-click in the UV Tex ture Editor and select "UV." Drag a 

selection square around the front of the body UVs and move 

them out of the one unit square. If you used the Paint Selec­

tion tool to select the faces on the front of the body, you will 

need to drop this tool before y ou can select the UVs in the UV 

Texture Editor. 

In your perspective window, select Show > Isolate Select > 

View Selection. The entire body and head are now visible again. 

In the UV Texture Editor, right-click and select "Face." Draw a 

selection around t he front of the body and the head UVs. In 

your main window, go to Edit > Inver t Selection. In the perspec­

tive view, go to Show > Isolate Select > View Selection. This will 

hide the head and front of the body faces. You can see that each 

time you create UVs for sections of the body it makes it easier 

to select faces to hide, because they can be seen clearly in the 

UV Texture Edi tor when you select your model. Be careful not 

to place sections on top of other ones. 

Keep selecting parts of the anatomy, and use this technique 

of selecting faces in the UV Texture Editor and then hiding them 

so that it becomes easier to select the remaining sections for UV 

mapping. The rest of the body faces can be sectioned and UV 

mapped in the following manner. Each t ime you map a section , 

be sure to move it out of the way in the UV Texture Editor. 

BACK OF THE BODY - Planar mapping on the Z-Axis. 

TOP HALF OF THE ARMS - Planar on theY -Axis. 

BOTTOM HALF OF THE ARMS - Planar on theY-Axis. 

TOP HALF OF THE HANDS- Planar on theY -Axis. 

BOTTOM HALF OF THE HANDS- Planar on theY -Axis. 

TOP HALF OF THE FEET - Planar on theY -Axis. 

BOTTOM HALF OF THE FEET - Planar on theY-Axis. 

NOTE: If you bent the fingers into a more relaxed position , 

you can rotate your perspective v iew of the hand so that it 

is facing toward the camera. Go to Edit Polygons > Texture > 

Planar Mapping > Options. Next to Mapping Direction choose 

··eamera" and click Project. 

In the UV Texture Editor, you should now have the various 

sections of the body UVs scattered around the one unit square. 

None should overlap another. Spend some time untangling 

overlapping faces. Parts that are not long enough can be scaled 

up so that they appear closer to the real proportions of an arm, 

leg , torso, and so on. Scale the various UVs dow n to f it into 

the one unit square. After you move all the parts into it , next 

to and under the head UVs you r UV Texture v iew should show 

something similar to Figure 23 . 

MAYA TUTORIAL 

FIG. 23 THE UV SNAPSHOT OF THE ENTIRE BODY AND HEAD UVS. 
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SURFACING A HUMAN MODEL 

Color Map 

FIG. 25 THE THREE MAPS APPLIED TO THE ENTIRE BODY. 

Copyright 2004 Peter Ratner 

Htl~~ 3~ ISSUE 2 

Bump Map 

Now you are ready to make a UV Snapshot. In the UV Texture 

Editor go to Polygons > UV Snapshot ... For texturing the entire 

body, use the highest resolution possible. In Photoshop, make the 

image size at least twice as big. If you already have texture maps 

fo r the head, then scale your UV Snapshot in Photoshop to their 

approximate size. Make sure the color. bump, and specu lar maps 

match the scale of the lines seen in the UV Snapshot. 

Continue painting the rest of the body textures using the UV 

Snapshot as your guide. When you're done, save the color, bump, 
and specular maps as separate files to import into Maya. 

Figure 24 shows the three maps for the entire body and Figure 25 

illustrates the maps applied to the body. -
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BY WIWAM "PROTDN" VAUGHAN 

Reverse Foot Rig for LightWave [8] 

I 
love working on character models! I also love posing and 

animating the characters, but until LightWave [8] introduced 

the new Bone tools, I always tried to avoid character rigging at 

any cost. The new Bone tools in [8] have sped up the rigging process 

and afforded me the time to experiment w ith new setups. I've always 

enjoyed animating characters w ith the reverse foot rig setups that I 

have seen online, in training tapes, and in books, but they were always 

a long process that involved adding many Null objects to the rig. 

I set out to create an easy to set up reverse foot rig that worked 

without any Null objects, but gave the same functionality. rve 

worked w ith several talented animators to make sure that it's 

animator-friendly, so you should be able to be up and animating in 

minutes by following the steps below. Let's get started! 

SfEP 1: 

Load a Biped character into Layout and set up your workspace 

so that you can quickly create and adjust bones. I prefer to use 

the four-panel setup that mimics Modeler's default workspace. 

This is a throwback from when I created my rigs w ith Skelegons 

before [8]. 

W hen rigging , I like to turn the "Display Subpatch Level" 

down to "0" and change the top, back, and right viewports to 

"front Face Wireframe." Turn "Bone X-ray" on in the perspec­

tive v iewport to view the bones on top of the texture-shaded 

solid object. 

NOTE: 

I also like to hide the Camera and Light when I'm in the rigging 

process. 
YOU A CLEAR VIEW TO PLACE BONES 
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SfEP 2: 

Create four bones for the leg in the side view starting with the 

"Hlp" bone and working your way down to the "Ankle" bone. 

After you have created the bones, rename them so that they are 

easy to select from a list. 

Select the Thighbone and use Record Pivot Rotation (keyboard 

shortcut "P") on it to reset rotation settings. 

FIX THE GIMBAL LOCK IN THE THIGH 

SfEP 3: 

Create five bones for the reverse foot rig, starting with the "Heel" bone 

and working your way up to the "Ankfe2" bone. After you have created 

the bones, rename them so that they are easy to select from a list. 

Your two anklebones should line up tip to base. Use joint Move 

and Tip Move to make any last minute adjustments . 

LIGHTWAVE TUTORIAL 

THE KEY TO THE REVERSE FOOT RIG 
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REVERSE FOOT R/6 

STEP 4 : 

Select the "Hip" bone and the "Heel" bone and move them into 

place in the Back viewport. Create a keyframe and rest the bones 

(Keyboard shortcut Y ') in their new positions. 

Note: Make sure all bones are off. 

STEP 5: 

Let's set up the leg so we can move on to the foot rig I promised. 

Add a Null object and name it "Goal." Don't worry; this is for the leg 

not the foot. Move the Null to the base of the "Ankle" bone and set 

a keyframe if Auto Key is turned off. 

STEP 5- IrS A GOOD IDEA TO ZOOM IN AND PLACE 
THE GOAL ASACCURATELY AS POSSIBLE 

STEP 6: 
In the Motion Options panel, use the following settings. 

Hip: Unaffected by IK of Descendents 

Thig h: Inverse Kinematics for the Heading and flitch 
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Calf: Inverse Kinematics for the Pitch 

Ankle:Goal Object = "Goal" (Null), and turn on Full Time IK. A lso 

set the Target Item to "Ankle2." 

Goal: Parent the Goal to "Ankle2" 

LIGHTWAVE TUTORIAL 

SfEP7: 
Now for the easy reverse foot rig I promised. We have all the 

components we need; all that is left to do is set the Bone Strength 

to "0 " for the Heel and Footpad bones. See, that wasn't so rough 

of a ride! 

Turn on all Bones and make sure Enable IK is selected. 

NOTE: Feel free to hide bones that you don't need to select. I hid 

the Ankle Bones, Thigh, and Calf. 

SELECT THE BONES NEEDED TO ANIMATE 
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Let's take a look at how to use the four bones that control the foot. 

HEEL: 

The Heel bone allows you to pick the foot up and the IK in the leg 

will kick into action. When in Rotate mode, you can rotate the entire 

foot rig at the base of the Heel. 

FOOTPA D: 

The footpad is used by rotating the Heading and is perfect for 

stomping out a cigarette (Quit smoking - it'll kill you) or making a 

turn in a military march. 

TOES: 

Rotating the Toe bone w ill allow your character to balance on the 

tip of the toes as well as swivel at the tip of the toes. 

• 



FOOT: 

Rotating in the Pitch w ill bend the foot at the base of the toes. 

So there you have it. A fter you have set this rig up a few 

times you should be able to add i t to a character from scratch 

in just a few minutes. Take advantage of the priceless Mirror 

Hierarchy tool in [8] to duplicate this leg and foot setup to 

the opposite leg. I hope that you have found a new option for 

setting up a reverse foot, and I would like to encourage you to 

experiment with different setups and fi nd one that works for 

you. Good luck, and happy animating . '* 
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MY COMPUTER ISN'T 

BY BRAD CARVEY 

I 
magine a new computer, 1000 times 

faster than any currently available 

home computer, with 1000 Gbytes 

of memory, a 3000 Ghz CPU, and a 2,000 

terabyte hard drive (I terabyte = 1000 Gbyte). 

Sounds pretty good, especially if you are 

rendering long, complex 3D animations. 

However, compared to the first personal 

computers. today's computers are 1000 

times faster. 

The first personal computers that I used 

were ones that I designed and built myself. I 

had to write both the operating systems and 

the applications. All programming was done 

by entering indMdual numbers, one at a time, 

into the computer's 512 bytes of memory. My 

first commercial PC was a Sinclair ZX-80 that 

I assembled from a kit for $99. This computer 

came with a whopping I or 2 k of ram, and 

if you needed it. a 16 Kbyte ram module was 

available. The module was bigger than a pack 

of cards and cost almost as much as the com­

puter. At the time, more of Timex's version of 

the Sinclair ZX-80 were sold than Apple and 

IBM computers combined. Next came the 16-

bit computers, like the Commodore 64, which 

could address 64 Kbytes of ram. 

The first computer I used to do 3D 

animations was the Amiga 2000, with a 

68020 processor running at 28 Mhz. It 

would take a mere hour to render a small 

shaded red ball w ith a specular highlight. 

However, things have changed. My cur­

rent computers have 2 Gbytes of memory, 

which is about 1000 times more than the 

Amiga 2000, 40,000 times more than the 

Commodore 64, 125.000 times more than 

the Sinclair, and an incredible 4 million times 

more than my first hand-built computers, 

So your own personal computer is 

probably sounding pretty good right now. 

After all, it is many times faster than a 

Cray- 1, which was over a million dollars and 

required fu ll time engineers to keep it op­

erating. The reality is, though, that it's not 

nearly fast enough. E.ven when personal 

computers are 1000 times faster, they will 

still be too slow for computer artists. 

A few years ago, working with video 

FAST ENOUGH 
resolution was difficult and time consum­

ing. Film was out of the question. Today, it 

is easier for computer artists to work w ith 

film resolution shots than it was to work with 

video shots back then, but major studios 

still figure a one-hour-per-frame rendering 

time as acceptable. That has not changed 

much. but the complexity of the shots 

has changed. Imagine rendering 100,000 

frames at 2048 x 1556 with high quality 

radiosity. Film is typically rendered to the 

Cineon format, which is about 12 Mbytes 

per image. For an hour of 3D animation, 

you would need 1,000,000,000,000 bytes 

of storage. That would require only four 

250 Gbyte hard drives. That's not too bad. 

But on a single computer, taking an hour 

to render a frame, it would take 10 years 

for 60 minutes of animation. If you used 

10 computers, then you would only need 

one year, and w ith 100 computers it would 

only require a little more than a month. If 

you were thinking computers were fast, by 

now you may be thinking that they are way 

too slow. 

Typically, film shots are rendered at 2048 

x 1556, known as 2k Full aperture. This is 

the size of the digitized fi lm typically used 

today for adding visual effects o r rendering 

animations. Some animations are rendered 

at lk ( 1024 x 778) and then processed to 

double the resolution to 2k before conver­

sion to film. With a dual processor and 4 

Gbytes of memory, it's not too difficult 

to do compositing with film even when 

its digitized at 4K resolution (48 Mbytes 

per frame), which is occasionally used on 

high-end projects. IMAX film is about eight 

times the size of the 35 mm film that is used 

for the majority of feature films. I have not 

worked with IMAX film, but I assume that it 

would be 96 Mbytes per frame. The current 

top of the line multiprocessor computer 

can handle film compositing and animation 

reasonably well. 

just when computers were starting 

tocatch up with my typical film work, a job 

came along, one that was too much for 

even the best workstations available today. 

A client requested content for a video wall. 

The wall has 48 projectors. E.ach one was 

rear-projected onto a special g lass wall. 

The wall's resolution (pixel dimension) was 

a daunting 15,360 x 4096 pixels. That's 63 

Mbytes per image, or about 755 Mbytes 

per second. The resulting animation was 

around three minutes long and required 

delivery on an 80 Gbyte hard drive. 

Part of the job was to determine what 

tools would be useful for scientists to 

enable them to display their conten t on 

the wall. Most of the software I tried did 

not work with the large image sequences. 

After Effects and Digital Fusion would usu­

ally start rendering a composite, but would 

freeze up or quit after a few frames were 

finished. None of the editing software I 

tried would handle the large frames. 

It was like the old days. My computer 

was the equivalent of the Amiga and took 

hours to do even simple tasks. The fancy 

compositing and editing programs did not 

work and I was required to be creative to 

get the tools I had to complete the job. I 

was able to do a lot of image manipulation 

in Photos hop w ithout problems. LightWave 

was used for everything else. It was a pain 

to use LightWave for editing, compositing, 

color correction. and everything else that 

needed to be done, but it was the only way. 

This job brought my computer to its knees 

and reminded me of how it used to be, and 

how it always will be. a 
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